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Abstract

The monitoring of wide-area hydrologic events requires the manipulation of large amounts
of geospatial and time series data into concise information products that characterize the location
and magnitude of the event. To perform these manipulations, scientists at the U.S. Geological
Survey Center for Earth Resources Observation and Science (EROS), with the cooperation of the
U.S. Agency for International Development, Office of Foreign Disaster Assistance
(USAID/OFDA), have implemented a hydrologic modeling system. The system includes a data
assimilation component to generate data for a Geospatial Stream Flow Model (GeoSFM) that can
be run operationally to identify and map wide-area streamflow anomalies. GeoSFM integrates a
geographical information system (GIS) for geospatial preprocessing and postprocessing tasks and
hydrol ogic modeling routines implemented as dynamically linked libraries (DLLS) for time series
manipulations. Model results include maps that depicting the status of streamflow and soil water
conditions. This Users Manual provides step-by-step instructions for running the model and for
downloading and processing the input data required for initial model parameterization and daily
operation.

Introduction to GeoSFM

The Geospatial Stream Flow Model (GeoSFM) was devel oped to establish a common visual
environment for the monitoring of hydrologic conditions over wide areas (Artan and others, 2001).
The monitoring activities include topographic analysis, data assimilation, time series processing,
and presentation of the results. The GeoSFM is designed to use remotely sensed meteorological
data in data sparse parts of the world (Artan and others, 2007). Many of the data setsinvolved in
these processes are raster grids. The spatially distributed nature of the raster grids used in these
processes required the adoption of a customizable geographic information system with excellent
raster functionality. The ArcView GIS software was adopted for the implementation because it
provided a visual, customizable development environment with excellent support of raster



operations. An ArcView extension was developed (in Avenue) for the geospatial processing
operations and for initializing time series analysis tasks. Routines for performing the hydrologic
computations involved in mass balance and routing were developed in a mixed programming
environment (C/C++ and Visua Fortran) and compiled as dynamically linked libraries (DLLS).
These DLLs are called up directly from within ArcView scripts, eliminating the need to develop a
separate interface for hydrologic routing operations. Descriptions of the algorithms used within
these programs are presented in the GeoSFM Technical Manual (Asante and others, 2007a). This
Users Manual describes the software components, data sets, processing steps, and input/output files
associated with running the model. 1t aso includes appendices which provide step-by-step
instructions, with associated screen images, to guide users through model set up procedures.

Preprocessing Module

GeoSFM’ s preprocessing module consists of routines for performing terrain anaysis,
extracting subbasin characteristics, and estimating unit hydrograph responses. The terrain analysis
routine delineates rivers, subbasins, and other elevation derivatives such as slope and drainage area.
The subbasin characterization routines extract hydrologic parameters from elevation, soil, and land
cover datainto files for use in subsequent model operations. The response estimation routine
computes the distribution of flow at the subbasin outlet following an instantaneous input event. It
storesthe result in atext file for use in flow simulations. This section of the Users Manual begins
with instruction on installing GeoSFM, followed by instructions for completing the preprocessing
tasks.

Model Installation

Asshowninfigure 1, GeoSFM consists of a series of nine directories containing programs,
documents, and data sets. The PROGRAM S directory contains the software executables and DLLs
used in GeoSFM. It also contains a batch file for installing and registering the software on the local
computer. The DOCUMENTATION directory contains this Users Manual and the accompanying
Technical Manual. The PRESENTATION directory contains illustrated presentations used for
classroom instruction of new users. The DEMDATA directory contains elevation data from the
USGS HYDROI1k data set (Verdin and Greenlee, 1996). The SOILDATA directory contains soil
parameters derived from the FAO/UNESCO Digital Soil Map of the World (FAO, 1995). The
LANDCOQV directory contains a grid of vegetation data from the Global Land Cover
Characteristics (GLCC) database (Loveland and others, 2000). The RAINDATA and EVAPDATA
directories contain samples of the rainfall and evapotranspiration grids used in model computations.
The SAMPLES directory contains input and output text files from a sample application of GeoSFM
for the Limpopo Basin (Asante and others, 2007b), which is used for illustrating model
functionality in this manual. The data files are distributed by CD-ROM or by download from the
USGS EROS Web site.



Figure 1. Components of the Geospatial Stream Flow Model.

GeoSFM
DEMDATA RAINDATA EVAPDATA LANDCOV
elevation rain_1999 evap_1999 usgslandcov
rain_19991 evap_19991
rain_1999365 evap 1999111
SOIL and L C Data PROGRAMS PRESENTATIONS DOCUMENTATION
ks geosfm.avx v1.0 GeoSFM Technical Manua
maxcover geosfm.dll GeoSFM Users Manual
ren geosfmcalib.exe
soildepth geosfmgzip.exe
texture geosfmpost.exe
whc geosfmstats.dll
veg geosfmtar.exe
install.bat
SAMPLES
Grids Shapefiles Textfiles Textfiles Project
basins basplyl.shp actualevap.txt localflow.txt project.apr
downstream rivlinl.shp balfiles.txt logfileflow.txt
elevations limpbas.shp bal param.txt logfilesoil.txt
flowacc gauges2.shp baseflow.txt mssbal ance.txt
flowdir basin.txt maxtime.txt
flowlen basinrunoffyield.txt | obsflow.txt
hilllength cswater.txt order.txt
outlets damlink.txt rain.txt
slope damstatus.txt rainstations.txt
streams describe.txt rating.txt
strlinks evap.ixt response.txt
traveltime evapstations.txt river.txt
velocity excessflow.txt riverdepth.txt
dem forecast1.txt routfiles.txt
forecast2.txt routparam.txt
forecast3.txt soilwater.txt
gwloss.txt streamflow.txt
inflow.txt testfile.txt
initial.txt times.txt
interflow.txt

To install GeoSFM, download or copy from CD all files described above to your C: drive.

The GeoSFM software files listed in table 1 must be installed in the ArcView 3.x extension
directory. The other files will be needed to complete the tutorials.




Table 1. Description of Software Programs in GeoSFM.

Files Description

geosfm.avx GeoSFM’ s ArcView 3.x Extension; provides the model interface

Geosfm.dll GeoSFM’s Dynamically Linked Libraries; contain hydrologic analysis routines

Geosfmcalib.exe GeoSFM' s Calibration module; executes the multi-objection parameter estimation a gorithm.

Geosfmgzip.exe Freeware for unzipping weather data files downloaded via FTP, renamed for easy
identification

Geosfmtar.exe Freeware for untarring weather data files downloaded via FTP, renamed for easy
identification

Geosfmpost.exe GeoSFM utility for postprocessing calibration module results

Geosfmstats.dll GeoSFM Dynamically Linked Libraries for postprocessing simulation time series results.

Geosfmstats.exe GeoSFM executable utility for postprocessing simulation time series results.

INSTALL .bat GeoSFM installation utility for copying and registering program files to the local computer.

In c\GeoSFM\Programs, double-click the INSTALL .bat file and installation is compl ete.
Thisinstallation will copy all GeoSFM files and register the .dll files to your computer. Y ou will
need to create a new directory, c:\GeoSFM\workspace, for output files.

Open ArcView GIS by clicking the shortcut on your desktop or by selecting it
from your Programs menu. When ArcView opens, the Welcometo ArcView Gl Sdialog box is
displayed. Depending on the setup configuration, there are different ways to create a new project. If
the dialog box below is displayed, click the with a new View radio button under Create a new
project and click OK.

The Add data dialog box appears asking if you would like to add data to the View now.
Click No.

hadaata RS

@ whould vou like to 2dd data o the Wiew now?

Mo




If the dialog box is not displayed, as shown below, click the Views icon and then click the
New button in the untitled Project window. Thiswill open the View1 window. Click and drag the
bottom right corner to expand the view, and position the window next to the untitled Project
window.

Next, from the File menu, select Extensionsto load Geospatial Stream Flow Model and the
Spatial Analyst.

>

Check the boxes next to Geospatial Stream Flow Model and Spatial Analyst to load the
extensions to the project and click OK.

The Menu and tool bar will update to reflect the additional functions of the Geospatial
Stream Flow Model and the Spatial Analyst extensions.
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From the File menu, select Save Project As. Save your project to your workspace
c:\GeoSFM \wor kspace\ with the file name Limpopo.apr. The extensions will then be preloaded
next time you open the project.

Terrain Analysis

Click the Add Theme button to add the Limpopo Basin shapefile. Change the Data
Sour ce Types to Feature Data Sour ce. Add the shapefile named limpbas.shp from the
c:\GeoSFM\samples\limpbas directory. Click OK.

The Geospatial Stream Flow Model uses adigital elevation model for the delineation of
hydrologic modeling units.

+
Add the elevations grid to the View using the Add Theme button . Change the Data
Sour ce Typesto Grid Data Sour ce. Click elevations from the c:\GeoSFM\demdata directory
and click OK to add the DEM to the View.



Click and drag the Limpbas.shp theme to the top of the table of contents and check the box
so that it isvisible over the elevations grid.

Next, set the analysis environment from the Analysis menu by selecting Properties.
Change the Analysis Extent to Same As Limpbas.shp and the Analysis Cell Sizeto Same As
Elevations. All other parameters will adjust themselves. Click OK.



analysi P

Analyzis Extent ‘Same fis

Left I 535500.1875 Top | -7 36500
Enttom [-3488500 Right [ 1533500125

Analyziz Cell Size I Same Ag Elevations E3

CollSize 1000 da

Mumber of B ows fic

Mumber of Columns I 1004

Analysis Mask |Ma Mask Set B3|

Ok I Cancel I

Begin by clipping the DEM to the extent of the analysis area. In the Analysis menu, select
the Map Calculator. Double-click [Elevations] from the Layerslist and click Evaluate.

Select Map Calculation 1 in the table of contentsto display Theme in araised box. From
the Theme menu, select Save Data Set. In the Save Data Set: Map Calculation 1 dialog box,
navigate to the c:\GeoSFM \wor kspace directory, and in Grid Name, name your new grid extent
Limpopo_elev. Click OK.

+

Click the Add themes button to add the new permanent Limpopo_elev grid to the
View. Change Data Source Typeto Grid Data Source and click Limpopo_elev to add to the
View.

Next, remove all Themes except for the new Limpopo_elev theme. Select the Theme to be
removed by clicking Theme, which is now araised box. In the Edit menu, select Delete Themesto
remove the selected Theme. Continue until all themes are removed except for the Limpop_elev
theme. Multiple themes can be selected by holding down the shift key while selecting the themes.



From the View menu, select Zoom To Themes to focus on the new extent area. Y ou may
want to apply alegend suitable for elevation to the theme. To do so, from the Theme menu select
Edit Legend.

In the Color Ramps drop-down list at the bottom of the L egend Editor, select Elevation
#1 and click Apply.

Y ou are now ready to begin running the Geospatial Stream Flow Model!

In the Geospatial Stream Flow Model, select Complete Terrain Analysis from the drop-
down list.

Generate Basin Char

Generate Bazin Fezponze File

Generate Rain/Evap Data Files
Compute Soil W ater Balance

Compute Stream Flow

Perfarm Sensitivity Analpsis

Perform Model Calibration

Update Bankfull and Flow Statiztics
Dizplay Flow Percentile Map
Dizplay Flow Hydrographs

Confirm your working directory as ¢:\GeoSFM\wor kspace and click OK.



If you have existing river or basin coverages, you may add them. For thistutorial, select No.

Select the Corrected DEM asthe only existing grid and click OK.

#! Which Grids Do You Have?

Select ALL Existing Grids

Cancel

i,

Flows Drirection Grid

Flow &ccumulation Grid

Downztream Flow Length

Stream Grid

Stream Link Grid

Outlet Grid

Subbasin Grid hd|

Select Yesto confirm that you want to create the missing grids.

Confirm that the grid called Limpopo_elev isindeed the Corrected DEM.
Click OK.

10



The program should begin performing the terrain analysis. After awhile, depending of
DEM data resolution and modeling window spatial extend (time could vary from few seconds to
hours), it will ask you to input the stream delineation threshold. Thisis the minimum number of
cells that must be upstream of a given location before ariver can be initiated.

Use the suggested default of 1000 and click OK . Using a different threshold will resultin a
model with a different number of streams and watersheds.

In afew minutes, you should get a message telling you the terrain analysis is complete.
Click OK. (Limpopo.elev themeis replaced with Elevations theme during the processing.)

Basin Characterization

Next, you need to generate afile that summarizes basin characteristics. From the
Geogpatial Stream Flow Model menu, select Generate Basin Characteristics File.

11



Geospatial Strean Flow Model REEE LR
Complete Terrain Analyziz

Generate Basin Characteristics File

Generate Basin Responze File

Generate R ain/Evap Data Files
Compute Soil W ater Balance

Compute Stream Flow

Pertarm Sensitivity Analyzsiz
Perfarm Model Calibration

Update Bankfull and Flow Statistics
Dizplay Flow Percentile bMap
Dizplay Flovw Hydrographs

Confirm your working directory as c:\GeoSFM\wor kspace. Select Y es when presented
with the question Add Soils & LandCover Datato View?

Geospatial Stream Flow Model

g Add Sods & LandCover Data to View?

A list of the data sets you need will appear. Click OK.

The required data sets are provided for you in the c:\GeoSFM \soildata directory. Change
the Data Sour ce Typesto Grid Data Sour ce. Hold the shift key down to select all the grids (ks,
maxcover, rcn, soildepth, texture, and whc). Click OK to add them to the View.

12



The program will present anew list of your input grids including all the input parameters.

The program will produce two files containing the characteristics of each subbasin and
river. It will also produce afile containing the computational order, which isrequired for
subsequent program operations. When the processing is complete, a dialog box will appear
indicating the name and location of the output files. Click OK.

Below all the input grids are added to the table of contents.

13



Unit Hydrograph Response
From the Geospatial Stream Flow Model menu, select Gener ate Basin Response File.

tial Stream Flow Model EfERS G RE]
Complete Terain Analysiz

[Generate B azin Charactenztics File

Generate Bazin Res

Generate B ain/Evap Data Files
Compute Soil ‘W ater Balance

Compute Stream Flow

Perfarm S enzitivity Analysis

Perform kodel Calibration

Update Bankfull and Flow Statistics
Digplay Flow Percentile tMap
Dizplay Flow Hydrographs

Confirm your working directory and click OK.

Select the Non-Uniform from USGS Land Cover Grid option for determining the
overland flow velocity. Click OK.

14



A list of the required inputsis displayed. Click OK.

Click Y es when asked whether you want to add USGS Land Cover grid to the View.

Change the Data Sour ce Typesto Grid Data Sour ce. Select usgslandcov from
c:\GeoSFM\landcov directory and click OK to add the land cover grid to the View.

15



Confirm the names of the input grids and the Computational Order Filewith values
displayed in the Specify Required I nputs dialog box. Click OK.

Manning’'s N for different land cover types, derived from (Maidment, 1993), should now be
displayed. Use the default Manning's coefficient values for each of the land cover types. Click OK.

16



The program will compute a response file (similar to a unit hydrograph) for each subbasin.
This may take afew minutes. After the computations are complete, a dialog box will appear and
indicate to you the location of the output file.

Traveltime and Vel ocity themes are added to the table of contents. Also, the response table
isdisplayed. Click OK in the dialog box. Y ou have now finished the terrain analysis and have
generated the basin characteristics file and the response file. The basin and response files resulting
from these computations are stored for use in subsequent model computations.

Hydrologic Analysis Module

GeoSFM’ s hydrologic module contains several routines for moving water through the river
basin. The module contains a data preparation routine for extracting time series datafrom
geospatial gridsinto ASCII files by subbasins. The rainfall data presented here are derived from
algorithms developed by Xie and Arkin (1997), while the evapotranspiration data are derived using
the methods of Verdin and Klaver (2002). Two soil moisture accounting routines perform the
vertical separation of incident rainfall into atmospheric releases, surface runoff, and subsurface
flows. The module a so contains three river flow transport routines for simulating the horizontal
movement of water through the river network. The user is expected to prepare the input files,
perform a soil moisture accounting, and then route the output with one river using one of the
available routines. Instructions for completing the tasks are provided in the following sections, and
detailed algorithm descriptions are provided in the accompanying Technical Manual.

Preparing Input Time Series Files

In this next step, arainfal value will be estimated for each subbasin from the daily rainfall
grids. To begin this computation, from the Geospatial Stream Flow Model menu, select Generate
Rain/Evap Data Files.

17



Geozpatial Stream Flow Mode| [REEbEE 5N

Complete Terrain Analysis

Generate B azin Characteriztics File

Generate B azin Response File

Generate Rain/Evap Data Files

Compute Saoil water B alance

Compute Strearn Flow

Perform Sensitivity Analyzis

Perform kodel Calibration

pdate Bankfull and Flow Statistics
Dizplay Flow Percentile bMap
Dizplay Flow Hydrographs

Select Rainfall and Evapor ation when prompted to Select Parameter to Extract. Click
OK.

Next, you will be prompted to Enter M odel Parameters. Specify the location and dates to
be processed as shown in the figure below. The Rain Data Directory and Evap Data Directory
need to reflect the correct path; as seen below, these fields may need to be updated from the default
path. The End Day Number field should be changed from the default of 240 to 10, which will
result in a shorter processing time. Click OK.

18



After afew moments, a message box will appear indicating that the processing is complete.
The message also gives the location of the output files: rain.txt and evap.txt. Click OK.

Therain.txt file created from this process contains an average rainfall value in millimeters
for each subbasin per day. The evap.txt file contains a potential evapotranspiration (PET) valuein
tenths of millimeters for each subbasin per day. The routing program will use these files for
performing the soil water accounting.

Soil Moisture Accounting

The next item in the Geospatial Stream Flow Model menu allows you to compute how
much water is contributed to streamflow through the soil. From the Geospatial Stream Flow
Model menu, select Compute Soil Water Balance.

GeoSF U

Complete Terain Analyziz

Generate Bazin Characteristicz File

[Generate Bazin Responze File

Generate Bain/Evap Data Files

Compute Soil W ater Balance

Compute Stream Flow

Perform Sensitivity Analvsis
Perform Model Calibration

Update Bankfull and Flow Statiztics
Dizplay Flaw Percentile bap

Digplay Flow Hedrographs

Confirm the working directory as c:\geosfm\wor kspace. Click OK.

Y ou will then be prompted to verify the input and output files in the Enter M odel
Parameter s dialog box; use the default fileslisted. Click OK.

19



Next, Enter Modd Parameters as shown below; use the default values. Click OK .

For short runs (30 days or less) getting the initial soil moisture content correct greatly
influences the accuracy of your calculated flows. For thisrun, an initial soil wetness of 10 percent
of storage capacity (I nitial Soil M oisture value of 0.1) will be assumed.

Next, a prompt comes up to Select Flow Routing Method for Computation. The available
choicesare Linear Soil Model and Non-Linear Soil Model. For thistutorial, choose the Linear
Soil Modél option. Click OK.

20



The model computes the soil water balance and indicates the location of the key output file
containing the local contribution of each subbasin to downstream river flow. The Final Sail
Moisturetableisaso displayed. Click OK.

The basinrunoffyield.txt file produced will be used by the flow routing programin
subsequent operations. The basin polygon theme, basply.shp, is also color-coded to indicate the
spatial distribution of soil moisture at the end of the ssmulation period.

Check the box next to thistheme to turn it on, and make sure the themeisin araised box.
From the Theme menu, choose Hide/Show L egend to display the legend. There are three classes
of soil moisture: dry, moist, and wet.

O

The image provides you with visual information of the distribution of soil moisture at the
end of the simulation. The full time series of soil moisture values is written to the soilwater .txt file
which is stored in the working directory. Another important file stored in the same directory is the

21



basinrunoffyield.txt file, which contains the runoff values to be passed to the river transport
module.

Computing Streamflow

Finally, you get to the part engineers like; moving the water around. To begin, click the
Geogpatial Stream Flow Model menu and select Compute Stream Flow.
]
Geospatial Stream Flow Model MEEw=ERE

Caomplete Terrain Analyszis

Generate Bazin Characteristics File

aenerate B asin Responze File

Generate Fain/Evap Data Files

Compute Soil wWater Balance

Compute Strearn Flow

Perfarm Senzitivity Analyzis

Perfarm kodel Calibration

Update Bankiull and Flow Statistics
Dizplay Flow Percentile Map

Miznlav Flrw Hudraranhs

Specify your working directory. Click OK.

The next dialog box that appears alows you to verify or enter the simulation input files and
output files. Pay particular attention to the No. of Days of Forecast Required field. In this
example the forecast will be for a 3-day period. Click OK.

22
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Y ou will next be prompted to select the Flow Routing Method for Computation. The
choicesinclude: Simple Lag Routing M ethod, Diffusion Analog Routing M ethod, and
Muskingum Cunge Routing M ethod. Select the Smple Lag Routing Method for this tutorial.
Click OK.

The model will soon indicate that it has finished the computation and written the results to
the streamflow.txt file in the working directory. Click OK in the Stream Flow Routing Complete
dialog box.

23



The Streamflow.txt table is displayed in ArcView to alow you to browse through the
results of the analysis, and asimple ASCII version of the same table, the streamflow.txt file, is
written to the working directory. The file contains a streamflow value in cubic meters per second
for each stream during each simulation time step, in comma delimited format.

Parameter Calibration Module

While the goal of GeoSFM isto allow for rapid assessment of streamflow conditionsin
basins with little ground-based information, its precision in representing flow processes can be
greatly improved when observed flow information is available for adjusting initial parameter
estimates. A parameter calibration module isincorporated into GeoSFM to facilitate such
parameter adjustment within user-specified ranges. This module consists of one routine for
analyzing the sensitivity of model results to changesin parameter estimates and another routine for
testing different sets of selected parameters to determine which set results in the most accurate
model results. User instructions for these two routines are provided in the following section.
Detailed descriptions of the algorithms in the routines are provided in the accompanying Technical
Manual.

Performing Sensitivity Analysis

The sensitivity analysis evaluates the sensitivity of model outputs to changes in input
parameters, and it is used to determine which parameters to modify during calibration. To initiate
sensitivity analysis, select the menu item Perform Sensitivity Analysis from the Geospatial
Stream Flow M odel menu.

24



Geozpatial Stream Flow Model eSS

Complete Terain Analyzis

Generate Bagin Characternistics File

Generate Bazin Response File

Generate Rain/Evap D ata Files
Compute Soil '/ ater Balance

Compute Strearn Flow

Perfarm Sengitivity Analysiz

Perform Model Calibration

IIpdate Bankfull and Flow Statistics
Dizplay Flowe Percentile Map
Diigplay Flowe Hydrographs

The Working Directory dialog box will ask you to Specify your working directory. Click
OK.

The next dialog box displayed prompts you to Select theriver reach for sensitivity
analysis. In thistutorial, select basin 140 from the drop-down list and click OK.

The next dialog box will list the absolute limits for the sensitivity parameters. Use the
default values and click OK. Thislist shows the 20 different parameters that will be tested.
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At this point, awindow will open and display the number of data sets created and the
number of model runs completed. This method is a one-at-a-time method where one model run will
only have one parameter changed with all other parameters held constant. Twenty values are
sampled at equal intervals for each of 20 parameters, resulting in atotal of 400 model runs.

Thiswill take afew minutes to complete.
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When the process is finished, the number of model runs successfully completed will reach
400. A dialog box will display stating that the Sensitivity Analysisis Complete and the results
have been written to sar unoutput.txt.

The output file sar unoutput.txt will give you the mean absolute difference of test results
over the parameter range for each parameter. The greater the differences, the more sensitive the
parameter. Sensitivity analysisisimportant when preparing to calibrate so that resources are not
wasted on parameters that have little or no effect on model output.

In this example, parameters 1, 2, 5,
7, 18, and 19 show the greatest
differences as measured by the
largest standard deviations. The
parameters that are the most
sensitive are SoilWhc, soil Depth,
Interflow, BaseFlow, RivFPLOoss,
and Celerity.

The sensitivity analysis provides you with information on which parameters to focus on
during the calibration described in the following section.

Performing Model Calibration

The next menu item is Perform Model Calibration; from the Geospatial Stream Flow
Model menu, select Perform Model Calibration. The purpose of calibration is to adjust model
parameters to closely match the real system.
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Confirm your working directory. Click OK.

The next box will display the model calibration parameters. Both input and output files will
default in the display. Click OK.

The following dialog box displays the input and output files needed for the postprocessing
program. Click OK.
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Select the model configuration from the following drop-down list. Linear Soil M ode, Lag
Routing is the option selected for this tutorial. Click OK.

Copy the observed_streamflow.txt from the geosfm\samples directory and paste into your
working directory—in this example c:\\GeoSFM\wor kspace. In the next dialog box, select which
observed streamflow stations will be used for calibration. In this example there are two stations,
select 1 and click OK.

Next, select the basin ID for the streamflow station from the drop-down list. The streamflow
station used for thistutorial islocated in basin 140. Select 140 and click OK.
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Next, the parameters to be calibrated are selected. While the results of the sensitivity
analysis are important in this selection, your knowledge of the basin and your interpretation of the
deficiencies of the current model are also important in deciding which parameters to calibrate. In
this example, six parameters were chosen: SoilWhc, Depth, Interflow, BaseFlow, RivFPLoss, and
Celerity. These six parameters were the most sensitive from the sensitivity analysistutorial. Select
SoilWhc, Depth, Interflow, BaseFlow, RivFPL oss, and Celerity from the parameter list by
holding down the Ctrl key and clicking OK.

Y ou are now prompted to Define a Maximum No. of Runs. The number of runsis
dependent on the length of the streamflow record, the number of parameters being calibrated, and
the complexity of the parameter dependent model response for the watershed being tested. In this

30



tutorial, select 1440 as the default number of runs. There are other options in the drop-down list;
you may select a smaller number for a shorter processing time. For optimum results, more model
runs are better.

Click OK.

The How Should Conver gence Be M easured? dialog box is displayed with a prompt.
Select Objective Function Type and the Root Mean Square Error (RM SE). Click OK.

The following window will open and begin the calibration process. Notice the listed
parameters. This process will take some time because it needs to run through 24 samples and 1,440
iterations.

In this screen you see the calibration process is now running. The six parameters chosen are
displayed along with the lower and upper values. Thisis the beginning of the objective function
results for the samples. Each sample will display number of fluxes selected—in this example only
one flux was selected.
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When the sampling is completed, the next processis labeled “Begin metropolis shuffled
complex evolution,” which runsfor 1,440 iterations.

The next window will open and start the postprocessing.
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The postprocessing produces a time series file which lists the observed streamflow and
calibrated streamflow output values. The objectives postproc.out file lists the best calibration
valuesin the time seriesfile, and the trdoff _bounds.out displays the lower and upper boundaries
with the average streamflow from the sample runs. New basin and river files (basin.txt and
river.txt) containing the parameter set which resulted in the best fit between simulations and
observations are also produced for use in subsequent model runs. Y ou can aso revert to the
precalibration basin and river characteristics by restoring the information contained in the
basin_original.txt and river_original.txt files.

Postprocessing Module

One magjor advantage of performing hydrologic modeling in a geospatial environment is that
simulation results can be linked to river and basin feature representations, allowing the user to view
and interact with the results in a visual environment. Three postprocessing routines are provided in
GeoSFM to facilitate such interaction. The first routine computes characteristic flows for each river
reach and stores the results in the associated river shapefile. The second routine displays flow
results in color-coded maps by linking flow time series with the associated basin shapefile. The
third routine allows hydrographs to be plotted with a simple click any river reach. Instructions for
running these routines are described in the following sections.

Updating Bankfull and Flow Statistics

From the Geospatial Stream Flow Model menu, select Update Bankfull and Flow
Statistics to compute characteristic flows for each river reach and store the results in an associated
river shapefile.
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Confirm the working directory as c:\geosfm\wor kspace. Click OK.

The Basin Theme dialog box displays asking you to Select basin cover age/grid theme
from the drop-down list. Select basply.shp (basin polygon shapefile). Click OK.

Next, the GeoSFM Utilities dialog box opens with a prompt to Enter Model Parameters.
The input file defaults to streamflow.txt and the two output files default to monthlyflow.txt and
annualflow.txt. Click OK.
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If less than 9 months of data are supplied, the following Info dialog box will open. Click
OK.

The model will soon indicate that it has finished processing and has written the results to the
river stats.txt filein the working directory. Theriver stats.txt file contains the statistical estimate
of how much water is needed to fill ariver channel (carrying capacity.)

Click OK inthe Bankfull and Flow Characteristics Computed dialog box. Notice the
riverstats.txt tableis also displayed.

The View is updated and the annualflow.txt, monthlyflow.txt, river stats.txt, and
streamflow.txt files are added to ArcView astables.
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Display Flow Percentile Map

From the Geospatial Stream Flow Model menu, select the next item in the list: Display
Flow Percentile Map.

GeoSFR Lt

Complete Temain Analyziz

aenerate B azin Characterniztics File

[zenerate B azin Responze File

enerate Fain/Evap Data Files I
Compute Soil ‘% ater Balance "
Compute Stream Flow

Perform S ensitivity Analyzis
Perform Model Calibration

Update Bankfull and Flow Statistics

Digplay Flow Percentile Map

Digplay Flow Hydrographs
[ TR | =i AT

Confirm the working directory as c:\geosfm\wor kspace. Click OK.
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Select Streamflow.txt when prompted to Select Input Data Filein the Input Flow Time
Series dialog box. Click OK.

Select basply.shp when prompted to Select basin coverage/grid themein the Basin
Theme dialog box. Click OK.

Next, at the prompt Select day to plot flow percentile map, choose 1999010 from the
drop-down list. This example represents day 10 in the year 1999. Click OK.

After afew seconds, amap will display. The basins are now classified into three categories:
low flow, normal flow, and high flow.
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For the next example, day 13 was selected. Click OK.

Results for day 13 are seen below.
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Notice the decreasing flow trend in many headwater subbasins between day 10 and day 13.
Such images provide a visual representation of simulated flows, which allows you to quickly
identify areas of concern within the study area.

Displaying Hydrographs

GeoSFM provides atool for plotting and displaying hydrographs. Y ou may also open the
resulting file in a spreadsheet to plot out the hydrographs; Microsoft Excel spreadsheet software
provides some additional plotting options, and it does a good job displaying along time series. In
the View, make sure that you have basply.shp selected and displayed in araised box. To plot the
hydrographsin ArcView, go to the Geospatial Stream Flow M odel menu and select Display Flow
Hydrographsto activate the plotting tool.
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After you select Display Flow Hydrographs, your cursor changesto a“+”. Now click in
one of the subbasins for which you would like to create a hydrograph. The subbasin is now
highlighted to show that it has been selected, and awindow opens with the hydrograph displayed.
An ArcView hydrograph is produced showing the daily variation of flow at the outlet of the
selected subbasin.

Click several different subbasins to see how different hydrographs compare. Seeif you can
observe the downstream propagation of flow by comparing hydrographs from the headwater
subbasins to those farther downstream.
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Y ou can analyze questions such as
* Doesthe 3-day forecast indicate increasing or decreasing streamflows?
* Arethebasinswith high soil moisture the same basins with the most streamflow?

ArcView’s graphing capabilities are limited in the number of data points that can be plotted
and in the ability to manipulate graph elements to enhance the display. Y ou may want to import
individual ssimulation output files into other programs, such as Microsoft Excel spreadsheet
software, for presentation quality graphs.

GeoSFM Utilities

A number of utilities are included in GeoSFM for its use in operational settings.

* RAINDATA toolsfor downloading and processing data produced at USGS EROS for daily
GeoSFM runs

* GISDATA toolsfor performing routine tasks associated with comparing and integrating
satellite-derived datain raster format with vector station data

« DEMDATA toolsfor removing spurious pits which may exist in elevation data sets other than
the HY DRO1k

* TIMESERIEStoolsfor processing output files from hydrologic analysis to determine
representative flows at daily, monthly, and annual time scales
Instructions for using these utilities are given in the following sections.

Rain Data Tool for Downloading Data

GeoSFM contains several menu items designed to assist the operational user in retrieving
and processing daily rainfall and evapotranspiration data. The first Raindata option is Download
Rain/Evap Grid, which usesfile transfer protocol (FTP) and alive Internet connection to
download data from the USGS EROS anonymous FTP server. A listing of the data sets available
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for download from the USGS EROS FTP site for 16 days after initial collection is provided in table
2.

Table 2. Operational geospatial time series data available for download from the USGS EROS FTP

site.
Region Data Source Naming Convention Comments
Rainfall
Global NASA TRMM TRMM<YY><MM><DD>g
Africa NOAA RFE Rain_<YYYY><Jl>>g Integrates in situ gauge data
Asia NOAA RFE Rain_<YYYY><Jl>>g For limited project sites only
Potential Evapotranspiration
Global USGS GPET" Evap <YYYY><ll>>g

'Global Potential Evapotranspiration data set from USGS EROS

From the main toolbar, go to GeoSFM Utilities and select Raindata: Download
Rain/Evap Grid from the drop-down list.

; oad Rain/Evap Grid
Faindata: Unzip, Untar, Imagegrid
Raindata: ProjectGid, Geo to Lambert Azimuthal

GIS Tools: Compute Rain/Evap Grid Statistics
GI5 Tools: Pick GridWalues at Point

GIS Tools: Interpaolate Station D ata to Gnd
GI5 Tools: Generate Rain/Evap D ata Files

DEM Toals: Fill Sinks in DEM

Time Series: Convert Daily to Monthly and &nnual
Time Series: Compute Daily Characteristic Flows
Time Senies: Compute Frequency Distribution

Specify your working directory. Click OK.

At the prompt, use the default entries. Click OK.
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In the Specify Type Data to Download dialog box, select Get Rainfall Gridsfrom the
drop-down list. Click OK. (Get Global PET Gridswould be selected for PET data.)

In the Select theregion for analysis dialog box, select Africa from the drop-down list.
Click OK. The latest available datawill be displayed for the region selected.

Wait for the FTP transfer to complete (Internet connection must be open). The program
writes alocal file with the selected regional data sets. The available rain/evap data will be displayed
for downloading. Generally, 16 days of data are available for downloading from the FTP site.

Select ALL Gridsto be downloaded by clicking and highlighting each selection that you
want to download. For this tutorial, 10 days of datawere used. Click OK. The naming convention
for raindataisrain_YYYYJl.tar.gz (*Y"—year, “J —=Julian day). The naming convention for
evapotranspiration datais YYMMDD.tar.gz (*Y”—year, “M”—month, “D”—day).
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The GeoSFM Utilities box appears with the message Data Transfer Complete and the
number of files downloaded. All downloaded files will now be in your working directory. Click
OK. This process can be repeated for downloading PET data.

Rain Data Tool for Image to Grid Conversion

The second Raindata option is atool for extracting and converting downloaded time series
images into Arclnfo grid format. From the main toolbar, go to the GeoSFM Utilities tool and select
Raindata: Unzip, Untar, Imagegrid from the drop-down list.

Faindata: Download Rain/Evap Grid

Faindata: Unzip, Untar, Imagegrid
Raindata: ProjectGnd, Geo to Lambert Azimuthal

GIS Tools: Compute Fain/Evap Grid Statistics
GIS Tools: Pick Grid ¥ alues at Paint

GIS Tools: Interpalate Station D ata ta Grid
GI5S Toolx: Generate Rain/Evap Data Filez

DEM Toals: Fill Sinks in DEM

Time Series: Canwvert D aily to Monthly and Annual
Timme Seriez: Compute Dailp Characternistic Flows
Timme Seriez: Compute Frequency Diztibution

Specify your working directory. Click OK.



Select ALL zipped Gridsto be processed by clicking and highlighting each selection that
you want to process. Click OK.

Next, Select ALL image files (*.bil) to be converted to grids by clicking and highlighting
each item. Click OK.

A dialog box will appear for each file; confirm your directory. Click OK for each dialog
box—one for each rain file to download.
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At the same time, the rain grids will be added to the table of contentsin anew View labeled
Geographic View.

When all processing is complete, the GeoSFM Utilities dialog box will appear, stating
Data Processing Complete, along with the number of grids processed and directory information.
This process can be repeated for PET data. The grid naming convention for raindataiis
Rain_YYYYJlg (for example, Rain_1999001g), and for evapotranspiration data Evap_YYY'Y JlJg
(for example, Evap_1999001g).
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All Rain_YYYYJJJg themes are added to the table of contents as seen below. (A g at the
end of agrid name indicates the geographic projection.)

>

Rain Data Tool for Projecting Grids

From the main toolbar, go to the GeoSFM Utilities tool and select Raindata: ProjectGrid,
Geo to Lambert Azimuthal from the drop-down list to project the grids from geographic to the
Lambert Azimuthal projection.

GeoSFM Utilities

Faindata: Download Rain/Evap Grid
Raindata: Unzip, Untar, Imagegrid

Raindata: ProjectGrid, Geo to Lambert Azimuthal

GIS Tools: Compute Fain/Evap Grid Statistics
GIS Tools: Pick Grid ¥ alues at Paint

GIS Tools: Interpalate Station D ata ta Grid
GI5S Toolx: Generate Rain/Evap Data Filez

DEM Toals: Fill Sinks in DEM

Time Series: Canwvert D aily to Monthly and Annual
Timme Seriez: Compute Dailp Characternistic Flows
Timme Seriez: Compute Frequency Diztibution

Specify your working directory. Click OK.
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In the Select the continent for analysis dialog box, select Africa from the drop-down list.
Click OK.

Select Yesin the Do you want to project the grid(s) from Geographic Coordinate
System to Lambert Equal Area Azimuthal dialog box.

Next, the Analysis Propertiesfor Rain_YYYYJJJgisdisplayed; accept the default values
and click OK.
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Select Y es when prompted Do you want to use thisanalysis extent for all grids?

After afew seconds, the Lambert Azimuthal View window opens with the
Rain_YYYYJJJ themes projected in Lambert Azimuthal Equal Area projection. (Notice the g at
the end of the grid nameis no longer displayed.)

Now the Rain_YYYYJJJ grids can be added to the View when prompted during the
Generate Rainfall and Evaporation Basin Files.
GIS Tool for Computing Grid Statistics

GeoSFM contains a number of tools designed to facilitate some commonly performed
operations. From the GeoSFM Utilities menu, select GI S Tools: Compute Rain/Evap Grid
Statistics.
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GeoSFM Utilities
Raindata; Download Bain/Evap Gnd
Raindata: Unzip, Untar, Imagearid
Raindata: ProjectGnd, Geo to Lambert Azimuthal

GIS Tools: Compute Rain/Evap Grid Statistics
GIS Tools: Pick Grd ¥alues at Point
GIS Tools: Interpolate Station D ata to Grid

GIS Tools: Generate Rain/Ewap Data Files
DERM Tools: Fill Sinks in DEM

Time Serez: Convert Daily to Monthly and Annual
Time Series: Compute D aily Characteristic Flows

Time Sernesz: Compute Frequency Distribution

The M odel Parameter s dialog box is displayed; confirm the Output Directory and typein
the correct path for the Rain Data Directory and Evap Data Directory. Confirm the Start Y ear
and End Year fields. Enter the Start Day Number and the End Day Number field for the time
frame you want to compute. In this example, the End Day Number was changed to 10 from the
default value for faster processing time. Click OK.

At the prompt, select Both Rainfall and Evaporation Gridsto compute local statistics.
Click OK.
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Next, the Local Statistics Type dialog box appears with alist of various statistics that can
be computed. Select the statistic to be computed from the drop-down list. For this tutorial, select
GRID_STATYPE_SUM, which will display the sum rain/evap for the 10-day date range defined
in the M odel Parametersdialog box. Click OK.

After afew seconds for processing, the R1I0SUM 1 Theme (sum of the rain datafor 10 days)
isdisplayed.

After afew more seconds if it’s correct, the ELOSUM1 Theme (sum of the evap datafor 10
days) is displayed.
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Run through the process again and select a different type of statistic to compute; compare
the differencesin the displayed data.

GIS Tool for Point Sampling of Grids

The second menu item is GIS Tools: Pick Grid Values at Point. Use this menu option to
extract rainfall and evaporation grid data at points into a shapefile/coverage. To begin this process,
apoint theme is required. Instructions for creating such atheme are provided in Appendix 5 of this
document. For completing this tutorial, a point theme is provided in the Geosfm\samples\point
theme directory.

First, to add a Theme, click the Add Theme button . From the Add Theme dialog
box, navigate to the c:\geosfm\samples\point theme directory.

In the Data Sour ce Types box, make sure Feature Data Sour ce is selected. Highlight
gauges2.shp and click OK.
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This shapefile contains randomly defined points just for use in thistutorial; these points do
not reflect actual rain gauge station sites. Thisisto help you get an understanding of the
functionality available to you through the GeoSFM Utilities tool.

From the GeoSFM Utilities menu, select GIS Tools. Pick Grid Values at Point.

GeoSFM Utilities

Raindata: Download Rain/Evap Grid

Faindata: Unzip, Untar, Imageqrid
R aindata: ProjectGrid, Geo to Lambert Azimuthal

315 Toolz: Compute Rain/Evap Grid Statistics

GIS Tools: Pick Gnd Walues at Paoint

E15 Toolz: Interpolate Station Data to Grid
G315 Toolx: Generate Rain/Evap Data Files

DEM Tools: Fill Sinks in DEM

Time Series: Canvert D aily ta Monthly and Annual
Time Series: Compute D aily Characteristic Flows

Time Seriez: Compute Frequency Distribution

Confirm your working directory. Click OK.

Next, at the prompt to Select the Point Themeto be used, select gauges2.shp from the
drop-down list. Click OK.
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The Convert gauges2.shp dialog box opens. Convert the shapefile to agrid. Navigate to
the c:\geosfm\wor kspace directory. Name your new grid in the Grid Namefield. Click OK.

In the Conversion Field: gauges2.shp dialog box at the prompt to Pick field with output
header ID values, select Stations i. Click OK.

Next, at the prompt to Select Parameter to Extract, for this tutorial select Rainfall and
Evaporation. Click OK.

At the Enter Model Parameter s prompt, confirm the Output Directory and typein the
correct paths for the Rain Data Directory and Evap Data Directory. Confirm the Start Year and
End Year fields. Enter the Start Day Number and the End Day Number for the time frame you
want. In this example, the End Day Number was changed to 10 from the default value for faster
processing time. Click OK.
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It will take afew seconds for processing. When the processing is complete, a dialog box
will display showing the path of the two new output files. Click OK.

These two files contain the rain and evaporation data for the user-defined points (gauges)
for the first 10 daysin 1999.

GIS Tool for Interpolating Point Data

Thethird GI S Tools menu item listed in the GeoSFM Utilitiesis Interpolate Station Data
to Grid. Thisfunction is used when there are areas over which spatially distributed precipitation
datais not available. Data interpolation routines convert station readings into a continuous surface.
Both rainfall and evaporation tables are required. These tables need to contain station IDs along
with daily amounts of rainfall/evaporation for each station. Instructions for creating these tables are
included in the appendices of this Users Manual. For the purposes of thistutorial, tables are
provided in the c:\geosfm\samples\stations directory.

Create two new folders in your working directory labeled Raindata and Evapdata; this
will help in managing the data files that will be created from this process. Start by opening a new
View by clicking View and the New button from the project window.
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Tahles

Add the gauges2.shp file to the View using the Add Theme button from the View
menu. Change the Data Sour ce Types to Feature Data Sour ce. Click the gauges2.shp file from
your working directory and click OK to add to the View.

Next, add the rain station table to ArcView by selecting Tables and clicking the Add button
seen below.

@

Navigate to your working directory. In the box to List Files of Type, select Delimited Text
(*.txt) and select your .txt file (in this example, rainstations.txt). Click OK.
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Next, join the new rainstations.txt file to the attribute table of the gauges2.shp file.
Arrange both tables as seen below. Highlight the common column headers in both tables—
Stations i in Attributes of Gauges2.shp and Station idsin rainstations.txt. Make sure the
destination table is active (adding fields to Attributes of Gauges2.shp).

= WA TTems =1
rainstations.txt
& £ lpadta b AT EERRI SRR SRR e i A
Paint 1 -25.38056 | 28.31EEGREY ;I 1i 3 1} 3 7 7 ;I
Paint 2 -20.80722 | 2791055556 2 1 1} 1 ] )
Pairt 3: 2812778 27 62888889 3 3 1} 2 2 4
Pt 4: 28 72444 ¢ 2688611111 4 a 1} 0 2 2
Paint 5i -25.89583 27 93472222 5 1 i} 0 5 5
Paint Bi -2R.B3361 ; 27 91472222 [ 1 i} 0 ] 5
Paint ¥ i -2h BEEEY | 27 7H30556E 7 1 0 1 4 E
Paint 9 -26.034717 : 27.84500000 g 1 1} 0 ] )
Paint 9i -28.06222 2752111111 3 2 1} 2 2 4
Pairt 10% -25 4BEET : 2826361111 10 3 1} 2 3 7
Pairt 11: 2415944 : 27 47972222 LI 11 4 1} 2 1 3 LI
Pt E Eal AN ATEAN AT TAEAN0N0 L Eal c [n] a 1 fal
4l I 1l I ’

Click the Join icon. The new columns are added to the Attributes of Gauges2.shp table.

O

The new rain data fields are also added to the attribute table.

57



i} Attributes of Gauges2.shp E
: £ it o | i i e
Piaint 12 ¢ 2397500 § 27 72500000 5 0 2 1 3 0 0~
Piaint 13! 2295000 { 27 97388889 4 0 1] 0 5 0 1]
Piaint 14 2398111 {28 40000000 5 0 2 2 B 0 1]
Piaint 15§ 2293500 { 28 00416667 4 0 1] 0 B 0 1]
Piaint 16 22 59722 | 28 80630089 4 5 1] 0 4 0 1]
Piaint 17 ¢ 2290833 { 29 1416667 8 5 1] 2 3 0 3
Piaint 18 -22 22556 { 29 99055556 9 0 1] 0 1 0 1
Point 19 -22.49056 § 2993333333 10 1 1] 1] 1 1] 2i7
Point 200 -22. 72500 3009583333 12 1 1] 1 1 1] 3
Point 211 2277028 1 3053916667 16 2 1] 2 1] 1] 4
Point 221 -22.7E972 1 30 82694444 15 3 1 2 1] 1] 3 =
:\.I:..l bl b b Wl =tn b - n T W i n Tnn Tu Tn TuTn } 4 fal 1 fal I [n} [n] A T

Repeat this process for the evaporation data. Y ou can choose to process rainfall and
evaporation data separately or at the same time. The attribute table will need all the necessary data
for the selection made during processing.

Click the Add Theme button to add the Limpopo Basin shapefile. Change the Data
Sour ce Typesto Feature Data Sour ce. Add the shapefile named limpbas.shp from the
c:\GeoSFM\samples\limpbas directory. Click OK to add shapefile to the View.

+
Next, add the elevations grid to the View using the Add Theme button . Change the
Data Source Typesto Grid Data Sour ce. Click elevations from the c:\GeoSFM\demdata
directory and click OK to add the DEM to the View.

Next, set the analysis environment from the Analysis menu by selecting Properties.
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Change the Analysis Extent to Same As Limpbas.shp and the Analysis Cell Sizeto Same
AsElevations. All other parameters will adjust themselves. Click OK.

Now you are ready to start the process.

From the GeoSFM Utilities menu, select GIS Tools: I nterpolate Station Data to Grid.
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Geo3F Utilities

FRaindata: Download B aind/E vap Grd
Raindata: Unzip, Untar, Imagegrid
Raindata: ProjectGnd, Geo to Lambert Azimuthal

GIS Toaols: Compute Rain/Evap Grid Statistics
GIS Tools: Pick Gnd Walues at Paint

GIS Tools: Interpolate Station Data to Grid

GIS Tools: Generate Rain/Evap Data Files

DEM Toolz Fill Sinks in DEM

Time Series: Convert D aily to Monthly and Annual
Time Series: Compute Daily Characterniztic Flows

Time Series: Compute Fregquency Distribution
P T T Y W e T ™ S T

Select the point theme to be inter polated from the drop-down list. In this example, select
Gauges2.shp. Click OK.

Select Parameter to I nterpolate—in this example, select Rainfall and Evapor ation.
Click OK. If the evapotranspiration data are already provided as grids, they do not need to be
interpolated in this tutorial. If the evapotranspiration datawere in atext type formatted file, the data
will need to be interpolated.

Enter the output directory for rainfall gridsin a new raindata folder created in
c:\GeoSFM \wor kspace\raindata. Click OK.
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At the Select Rainfall Fields prompt, select the fields that contain the rainfall values. Select
the 10 days from the list, R1999001 through R1999010. Y ou may select any number of days for
which data are available. In thistutorial, select all 10 listed. Click OK.

Enter the Output Directory for Evaporation Grids in a new evapdata folder created in
c:\GeoSFM\wor kspace\evapdata. Click OK.

At the Select Evaporation Fields prompt, select the fields that contain the evaporation
values. Select the 10 days from the list, E1999001 through E1999010. Again, you may select any
number of days for which data are available. For this tutorial, select all 10 listed. Click OK.
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In the Start Date dialog box, change the default start date to 1/1/1999 to match the date of
thefirst rainfall/evap fields selected above. Thefirst field selected was 1999001 and represents
1/1/1999. All the grids created will be based on the Julian day. Click OK.

When asked if you would like to Add Interpolated Gridsto the View, click Yes.

Next, the I nter polate Surface dialog box is displayed.

Popul ate:

Method: options are I DW and Spline, select IDW (Inverse Distance Weighting)
Z Value Field: select the default, Stations i

Nearest Neighbors or Fixed Radius: select Nearest Neighbors

No: of Neighbors: select the default, 12

Power: change the Power field to 1 to create a smoother surface (default is 2)
Barriers: select the default, No Barriers

Once parameters are selected, click OK.
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It will take afew seconds to process the rainfall/evap grids. A process completion window
appears when it is complete. Click OK.

From the Theme menu, you may want to select Edit L egend and apply a precipitation color
ramp like the one below.

_| Ewvap_19929008
_| Ewap_1999007
_| Evap_1999006
_| Evap_i8ss003
_| Ewap_1299004
_| Evap_1999003
_| Evap_19929002

« Rain_1200010
[ o-o0752
[Jo7s2- 1523
[ 1523- 2285
[ ]2285- 3045
[ =046 - 3208

I 2802 - 4569 —
I 4559 - 5.331
B 5331 - 6.082
N 5002 . 5254

I
I
I
I
I
I
|
| _| Ewap_1299001
I
I
I
I
I
|

DEM Tool for Sink Filling

In this tutorial, GeoSFM’ s elevation grid filling tool is presented. The tool is used for filling
spurious sinks, while maintaining sinks that are natural occurrences in the landscape. Thistime-
consuming process yields a DEM that will properly transport water across its surface. This process
is best done on a smaller basin region than for an entire continent. If the elevation data are from the
HYDRO1k DEM data set developed at USGS EROS, then this process is not needed. HY DRO1K is
ahydrologically corrected DEM, which impliesthat it is devoid of spurious pits that interrupt
hydraulic connectivity over the land surface.
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To begin the process, add the Sinks_dem grid to the View using the Add Theme button

+
. Change the Data Sour ce Typesto Grid Data Sour ce. Click Sinks_dem from the
c:\GeoSFM\samples directory and click OK to add the DEM to the View.

The DEM is added to the View, as shown below.

The only menu item under DEM ToolsisFill Sinksin DEM. From the GeoSFM Utilities
menu, select DEM Tools:. Fill Sinksin DEM.
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GeoSEM Utiities

Raindata; Download Bain/Evap Gnd

Raindata: Unzip, Untar, Imagearid
Raindata: ProjectGnd, Geo to Lambert Azimuthal

GIS Tools: Compute Rain/Ewap Grid Statistics
GIS Tools: Pick Grd ¥alues at Point

GIS Tools: Interpolate Station D ata to Grid
GIS Tools: Generate Rain/Ewap Data Files

DEM Tools: Fill Sinks in DEM

Time Serez: Convert Daily to Monthly and Annual
Time Series: Compute D aily Characteristic Flows

Time Sernesz: Compute Frequency Distribution

Confirm your working directory. Click OK.

Next, the I dentify Input DEM dialog box is displayed. At the Select the Grid to be Filled
prompt, select Sinks_dem from the drop-down list. Click OK.

After afew moments for processing, the new fill1 grid is added to the table of contents. Y ou
may want to apply alegend appropriate to the elevation. To do so, from the Theme menu, select
Edit Legend.

In the Color Ramps drop-down list, select one of the Elevation choices and click Apply.
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The Sinks_dem file in the samples folder isremoved and a new fill1 grid is added to your
workspace directory. The resulting elevation grid is ready for use in terrain analysis.

Time Series Tool for Changing Temporal Resolution

The GeoSFM Utilities contains three time series tools for performing tasks commonly
required when examining simulation results. Thefirst of the three functionsis Convert Daily to
Monthly and Annual. From the GeoSFM Utilities menu, select Time Series. Convert Daily to
Monthly and Annual.

GeoSFM Utilties

R aindata; Download Rain/Ewap Grid
Raindata; Unzip, Untar, Imagegrid
Raindata: ProjectGnd, Geo to Lambert Azimuthal

GIS Tools: Compute Rain/Evap Gd Statistics
GIS Toolz: Pick Grid Values at Paint

GIS Toals: Interpolate Station Data to Gd
GIS Toolz: Generate Rain/Evap Data Files

DEM Toals: Fill Sinks in DEM

Time Series: Convert D aily to Monthly and Annual

Timne Senes: Compute Daily Charactenstic Flows

Time Senes: Compute Frequency Distribution

Confirm your working directory. Click OK.
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From the GeoSFM Utilities dialog box, Enter Model Parameters. The input file defaults
to streamflow.txt, and the output files are monthlyflow.txt and annualflow.txt. Click OK.

Next, at the Select Statistic to be Computed prompt, select Max. Click OK.

After afew moments of processing, the Time Series Conver sion Complete dialog box will
display as seen below. The program will produce two files containing the monthly and annual
streamflow amounts for each subbasin. The message contains the name and location of the output
files. Click OK.

Two new tables are shown below; the streamflow data was for afew days in January 1999.
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Time Series Tool for Frequency Analysis

Thelast tool in thistutorial is Compute Frequency Distribution. From the GeoSFM
Utilities menu, select Time Series. Compute Frequency Distribution.

GeoSFM Utilities

Faindata: Download Fain/E wap Grid
Raindata: Unzip, Untar, Imagegnd
Raindata: ProjectGnd, Geo to Lambert &zimuthal

GI5 Tools: Compute B ain/Ewvap Grid Statistics
GIS Tools: Pick Grid Walues at Point

GIS Tools: Interpolate Station D ata to Grid
GIS Tools: Generate Rain/Ewvap Data Filez

DEM Toals: Fill Sinks in DER

Time Senies: Comvert Daily to Monthly and Annual

Time Seriez; Compute Daly Characteristic Flows

Confirm your working directory. Click OK.

Next, the Select I nput Filefor Flow Statistics Computation dialog box is displayed.
Navigate to your working directory and under List Files of Type, select Comma Delimited
Textfile from the drop-down list. Select streamflow.txt as seen below. Click OK.
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When the Basin Theme dialog box is displayed, select your basin coverage/grid theme. In
this tutorial, the basin coverage selected is basply.shp. Click OK.

Next, the Select the statistics to be computed dialog box opens. In this example, Total
Flow, Mean Flow, Maximum Flow, and Minimum Flow have been selected. Notice that more
than one statistical type can be selected at atime from the list of options provided. Click OK.

Confirm Request to update L ow/Med/High Bankfull flow levelsis displayed. Select
Yes. Thisanalysisis not recommended for less than 10 years of data. Because you have only been
working with 10 days of data, the results of the analysis will not be meaningful. The objectiveisto
familiarize you with the functionality available in the GeoSFM Utilities tool.
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The next dialog box displayed is the Select field to display; in this example, M ean has
been selected. Click OK. Again, notice the list of options available for displaying the results. The
new calculations will be displayed in the basply.shp, overwriting what was displayed.

Below isthe updated basply.shp with the M ean value displayed.
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Y ou can change the value displayed. From the Theme menu, select Legend Editor. Then change the
Classification Field and click the Apply button. The Color Ramp selected is Y ellow to Green to
Dark Blue. Below, you can see the results with the Minimum classification field selected.

>

Below isthe result when the M aximum classification field is selected.

Notice the differences among the three different classifications. The maximum flow
classification is useful for quickly identifying subbasins through which the highest flows passed
during the analysis period.

Conclusions

Thismanual provides step-by-step instructions for running the GeoSFM software and
accompanying data sets for performing model setup, preprocessing, flow simulation, calibration,
and postprocessing tasks. It also provides instructions for running utilities for downloading daily
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data and processing of required time series grids and performing some common processing tasks
for elevation and time series grids and files. Additionally, five appendices are included with
detailed instructions for downloading and processing elevation, soil, and land cover data sets used
in parameterizing GeoSFM. The accompanying GeoSFM Technical Manual details the functions
underlying the menus described in this manual. Together, these two manuals should serve to
document the GeoSFM system for potential users seeking to assess hydrologic conditions in data
sparse settings (Artan and others, 2007).
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Appendix 1: Processing Elevation Data

GeoSFM can use any digital elevation model for the delineation of hydrologic modeling
units. The use of the HY DRO1k data set is described in this document because it is readily
available and easily distributed. The descriptions encompass the processes to download data and
initial processing to remove nodata cells and prepare the data set for use in GeoSFM. As with other
tutorials in this document, the Limpopo Basin in southern Africais used as the test basin.

These data are available from the U.S. Geological Survey Earth Resources Observation
Science (EROS) Center at http://edcdaac.usgs.gov/gtopo30/hydro/africa.html. This Web site brings
you to the Land Processes Distributed Active Archive Center. From this page, scroll down to the
list of downloads. (Datafor other regions are found at the same Web site at the following address:
http://edcdaac.usgs.gov/gtopo30/hydro/). The Web site allows you to download the entire African
data set (including elevation, compound topographic index, aspect, flow direction, flow
accumulation, slope, drainage basins, and streams) or any of itsindividual components.

Download the elevation data set by clicking Download HYDRO1k DEM for Africaasa
tar file (34.0MB). Save the file to the workspace, c:\GeoSFM\wor kspace. Use WinZip to select
and extract all filesto the workspace. Extract the af_dem.bil from the af_dem.bil.gz file. If you do
not already have WinZip installed, download afreetrial version from
http: //mawww.winzi p.comywinz p/downl oad.htm.

Extracted files:
af _dem.gz

af _dem.bil
af_dem.blw
af_dem.hdr

af _dem.stx
readme.af

Next, you need to add the elevation data to the ArcView project, convert it into the required
Arclnfo grid format, and make some corrections. Add the Digital Elevation Model to the View

. .
using the Add Theme button from the View menu. Change the Data Sour ce Typesto | mage
Data Sour ce. Click the af_dem.bil file from the c:\GeoSFM \wor kspace directory and click OK to
add the DEM to the View.

Next, the DEM will need to be converted to a grid. Select the theme Af_dem.bil so that it
appearsin araised box. Checking the box next to the theme name will make it visible.
From the Theme menu, select Convert to Grid.
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The Convert Af_dem.bil dialog box appears. Navigate to the c:\GeoSFM \wor kspace
directory and name your new grid Af_dem_grid in Grid Name. Click OK.

A dialog box appears asking if you would liketo Add grid asthemeto the View. Click
Yes.

The new Af_dem_grid themeis shown below.
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After adding the grid to the View, some map calculations must be performed to correct
abnormally high values that are introduced into the DEM to avoid having to store negative values
in the *.bil format. From the Analysis menu, choose Map Calculator.

The first correction subtracts 65536 from al the cells with elevation higher than 32768,
which restores the original negative values. The result of this computation isthat all NODATA
cells are assigned values of -9999 while all other cells will have their true elevation (negative or
positive).

In Map Calculator, type the following expression exactly as shown:

([Af_dem_grid] >= 32768).con( [Af_dem_grid] — 65536, [Af_dem_grid] )
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Click the Evaluate button. This produces a temporary grid called Map Calculation 1, seen
below.

Choose Map Calculator from the Analysis menu again to do the second calculation. The
second cal culation assigns values of zero to NODATA cells and values of oneto all other cells so
that the NODATA cells can be eliminated in the final step. Type in the following expression
exactly as shown:

([Map Calculation 1] =-9999 ).con (0.AsGrid, 1.AsGrid)
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Click the Evaluate button. This produces a temporary grid called Map Calculation 2, seen
below.

The final computation divides the result of the first correction with the result of the second
correction. Zero divides values of <9999 while 1 divides all other values. Division by zero resultsin
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aNODATA cell being created while division by 1 leaves the original value unaltered. Choose M ap
Calculator from the Analysis menu again and type in the following expression exactly as shown:

([Map Calculation 1] / [Map Calculation 2])

Click the Evaluate button. This produces a temporary grid called Map Calculation 3, seen
below.
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Because thisfinal elevations grid will be used for the rest of the tutorial, it needs to be made
permanent. Select the Map Calculation 3 Theme so it appearsin araised box. From the Theme
menu, select Save Data Set.

In the Save Data Set Dialog Box, navigate to the c:\GeoSFM \wor kspace directory and
name the new grid Elevationsin the Grid Namefield. Click OK.

Y ou can now remove al themes by selecting the theme so it appearsin araised box, and
then from the Edit menu, select Delete Themes.

Yiew Theme Graphics
Cut Thernes
Copy Themes

Delete Themes

[Irde Graphiz Edit Etilz

[Eut Eraphics [Etrl=
[Eopy GEraphics [Etrl+E

Now the permanent Elevations grid can be added to the View using the Add Theme button

+
. The resulting elevation grid isready for usein terrain analysis.
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Appendix 2: Defining Analysis Extent

GeoSFM uses a shapefile to define the analysis extent for use in the modeling process.
HY DRO1k Basins data sets are derived using the vector stream networks along with the flow
direction data set. Each polygon in the basin data set has been tagged with a Pfafstetter code
uniquely identifying each subbasin. Additional attributes defining the characteristics of each
subbasin have also been developed. These data are available in an Arclnfo export format and
shapefile format. The process for downloading data documented below captures data needed to
complete the terrain analysis tutorial. Thistutorial was developed for the Limpopo Basin in
southern Africa. The elevation data are available from the U.S. Geological Survey Earth Resources
Observation Science (EROS) Center at http://edcdaac.usgs.gov/gtopo30/hydro/af_basins.asp. Data
for other regions are also found at the Web site of the Land Processes Distributed Active Archive
Center at http:/edcdaac.usgs.gov/gtopo30/hydro.

The African HY DRO1k data set can be downloaded in its entirety, or individual layers can
be downloaded by selecting the data layer, see above. Detailed descriptions of the techniques used
in the development of the HY DRO1k data set can be found in the Readme file. The page contains
options for downloading the entire HY DRO1k data set for Africaas atar file (215.5 MB) or
downloading individual componentsin either Arcinfo export format or shapefile formats.

Click Download HYDRO1k Basinsdata set for Africa asatar filein shapefile format
(7.4 MB). Save thefile to your workspace, ¢c:\GeoSFM \wor kspace. Use WinZip to select and
extract all filesto your workspace. Extract all filesfrom the af_base.tar.gz file. If you do not
aready have WinZip installed, you can download afreetrial version from
http: //mawww.winz p.comywinz p/downl oad.htm.

Extracted files:

af .readme
af _bas.dbf
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af _bas.prj

af _bas.shp
af_bas.shp.xml
af _bas.shx

Next, you need to add the basin data to the ArcView project and select the basins for the
analysis area, which isthe Limpopo Basin in thistutorial. Add the basin datato the View using the

|
Add Theme button from the View menu. Change the Data Sour ce Typesto Feature Data
Sour ce. Click the af_bas.shp file from the c:\GeoSFM \wor kspace directory and click OK to add
to the View.

After adding the shapefile, select the basin area in the attribute table. Open the attribute
table by clicking the Table icon. From the Table menu select Query.

Field  window

Broperties. ..

LChart...

Start Editing
Save Edits
Save Edits &z

Find... Chrl+F
Quemn... Chel+0

Promate

The Attributes of Af_bas.shp query box opens.

Double-click Level 2 under Fields. Make sure the Update Values box is checked so all
Level 2 valueswill display under Values. Click the “=" button and then the value you need for this
basin. Select 54 for this tutorial. Click New Set.
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([Level?] = 54)

All attributes with avalue of 54 in the L evel2 column will have ayellow highlight. The
African shapefile will aso show the subbasins selected highlighted in yellow.

Now you can convert the selections to a shapefile. From the Theme menu, select Convert
to shapefile.

.Q.nalysis Surface  Graphics

Eroperties. .

Start Editing
Save Edits
Save Edits ds.

Caorwert o Shapefile. ..

Corweert bo Grid...

The Convert Af_bas.shp dialog box opens. Navigate to the appropriate directory and under
File Name type in the name of the new shapefile. Click OK.
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The Add shapefile asthemeto the view dialog box will display. Click Yes.

Below, the new shapefileis displayed.

The shapefile can be added to the View when prompted during the terrain analysis process.
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Appendix 3: Processing Land Cover Data
Download the data from the Internet at http://edcdaac.usgs.gov/glcc/af_int.html.

This Web site brings you to the Land Processes Distributed Active Archive Center—Global
Land Cover Characterization. From this page, scroll down to the Linksto land cover data sets.
Two different versions are available; select Version 2.

Select the appropriate area for download from the table shown below.

GLCC - Version 2

@Giobal North America l'Eurasia

';_‘Africa aSouth America # Australia Pacific

Select Africa because the study areais the Limpopo Basin in southern Africa. Create a new
folder in the GeoSFM folder called glcc for all of the land cover data. Selecting Africawill display
the Africa Land Cover Characteristics Data Base Version 2.0 page. From the Africa Land Cover
page, select Datain Lambert Azimuthal Equal Area Projection. This transfersyou to a page
with links to data and documentation in either compressed or uncompressed format. Scroll down
the page to the image files and click Compressed/3.3 Mb. Save thefile to c:\GeoSFM\glcc. Use
WinZip to select and extract all filesto your workspace. From the afusgs2_0l.img.gz file, extract
the afusgs2_0l.img. If you do not already have WinZip installed, you can download a free trial
version from http: //www.winz p.com/winzp/download.htm. Y ou can also elect to download the
uncompressed files directly if you have adequate bandwidth to support such a download.

The downloaded land cover datais provided in a generic image array format (flat,
headerless, binary raster data) to maximize the flexibility for importing the datainto a variety of
software systems. The following procedure is needed before importing these raster image filesinto
ArcView. First, rename the image file to afusgs2_0l.bsq (.bsq —image file— band sequential). Next,
create a header file with the following fields:
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nrows—the number of rows in the image

ncols—the number of columnsin the image

nbands—the number of spectral bands in the image; default is 1

nbits—the number of bits per pixel per band; default is 8

layout—the organization of the bands in the image file; acceptable values are hil, bip, and
bsq

skpbytes—the number of bytes of data in the image file to skip to reach start of image data
(bypass header information); default is O

ulxmap—the x-axis map coordinate of the center of the upper-left pixel

ulymap—the y-axis map coordinate of the center of the upper-left pixel

xdim—the x dimension of a pixel in map units

ydim—the y dimension of a pixel in map units

The image parameters needed to populate the new header file can be found in the
documentation for each of the continental databases. For example, the projection parameters for the
Limpopo study area can be found by clicking Africa Documentation and scrolling down to
section 2.2 Lambert Azimuthal Equal Area Projection Parameters. The data dimensions of the
Africaland cover characteristics data set are 9,276 lines (rows) and 8,350 samples (columns),
resulting in a data set size of about 77 megabytes for 8-bit (byte) images. The map projection
parameters are as follows:

Projection Type: Lambert Azimuthal Equal Area
Units of Measure: meters

Pixel Size: 1,000 meters

Radius of sphere: 6,370,997 m

Longitude of origin: 20 00 00 E

Latitude of origin: 500 00 N

False easting: 0.0

False northing: 0.0

XY corner coordinates (center of pixel) in projection units (meters):
Lower left: (4458000, —4795000)

Upper left: (4458000, 4480000)

Upper right: ( 3891000, 4430000)

Lower right: ( 3891000, —4795000)

Prepare an ASCII header file in any text editor, such as WordPad, as shown below.
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File Edit Miew Insert Fol

D= SR #

[l I

[SEERRRRARER

nrows 9276
ncals 8350
nbands 1

nhits

layout bsg
skipbytes 0
ulxmap -4458000
ulyrmap 4480000
xdim 1000

ydim 1000

Save the document from the file under the name afusgs2_0l.hdr in the directory
c:\GeoSFM\glcc. The land cover data must be added to the ArcView project and converted into a
grid for use in GeoSFM. Add the afusgs2_0l.bsqg file to the View using the Add Theme button

+
from the View menu. Change the Data Sour ce Types to | mage Data Sour ce. Click the
afusgs2_0l.bsq file from the c:\GeoSFM \glcc directory and click OK to add the land cover datato
the View.

The land cover datawill not display until it has been converted to agrid. To convert the
land cover datato agrid, select the theme afusgs2_0l.bsq so that it appearsin araised box. From
the Theme menu select Convert to Grid.
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The Convert Afusgs2_0l.bsq dialog box appears. Navigate to the c:\GeoSFM\glcc
directory and type in usgslandcov in Grid Name. Click OK.

A dialog box appears asking if you would liketo Add grid asthemeto the View. Click
Yes.

A new usgslandcov theme is shown below.

Next, you need to add the Lu_code and description fields to the attribute table.
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AfricaLand Cover Characteristics Data Base Version 2.0

@ Africa Readme

@ Africa Land Cover Database Table

@Data in Interrupted Goode Homolosine Projection
@Data in Lambert Azimuthal Equal Area Projection

Value Code Description
1 100 Urban and Built-Up Land
2 211 Dryland Cropland and Pasture
3 212 Irrigated Cropland and Pasture
4 213 Mixed Dryland/Irrigated Cropland and Pasture
5 280 Cropland/Grassland Mosaic
6 290 Cropland/Woodland Mosaic
7 311 Grassland
8 321 Shrubland
9 330 Mixed Shrubland/Grassland
10 332 Savanna
11 411 Deciduous Broadleaf Forest
12 412 Deciduous Needleleaf Forest
13 421 Evergreen Broadleaf Forest
14 422 Evergreen Needleleaf Forest
15 430 Mixed Forest
16 500 Water Bodies
17 620 Herbaceous Wetland
18 610 Wooded Wetland
19 770 Barren or Sparsely Vegetated
20 820 Herbaceous Tundra
21 810 Wooded Tundra
22 850 Mixed Tundra
23 830 Bare Ground Tundra
24 900 Snow or Ice

Value 330 not recognized in model need to add

Now that you have the data you need, you can prepare an ASCI| file. Open WordPad
(Start/Programs/A ccessories/WordPad). Cut and paste the data into WordPad.
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Commas need to be added to separate column values, and each line needs to be on a
separate row. The header and the first line of data also need to be added.

Add header names and values:

Value, Code, Name

0, 0, Unclassified—notice the commas separating field values
An example of the WordPad document can be seen below.

To save the document, from the File menu, select Save As.
File Name—usgslandcov.txt

Save as Type—T ext Document
Directory—c:\GeoSFM\glcc

Click new grid theme so it appearsin araised box. Click table icon to open attribute table.
The table should contain Value and Count fields.
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Next, you need to add the new usgslandcov.txt file that was created.

Click Tables, Add in the project window.

The Add Table dialog box will open. In c:\geosfm\glcc, select usgslandcov.txt. List of
Filesof Type: Delimited Text (.txt) should be displayed. Click OK.

Arrange both tables as seen below. Highlight the common column headers in both tables—
Valuein Attributes of usgslandcov and Value in usgslandcov.txt. Make the destination table
active (adding fields to Attributes of usgslandcov).
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Click the Join icon. The new columns are added to the Attributes of usgslandcov table.

T~

Once the new fields are added to the attribute table, you need to make the added data
permanent.
From the Table menu, select Start Editing.

#2 Arc¥iew GIS 3.2a
Eile Edit Field ‘indow He

Saye Editz
Save Edts s

......

Then from the Edit menu, select Add field.

Two fields will be added.
Field One:

Name: Lu_Code

Type: Number

Width: 3

Decimal Places: 0

After Field Definition is populated, click OK.
Field Two:

Name: Description

Type: String

Width: 50
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After Field Definition is populated, click OK.
Next, populate the column values for the new fields by using the Field Calculator icon on
the tool bar. Click the Field Calculator icon.

The Field Calculator dialog box opens—double-click [Code] under Fields.
The calculation is expressed as[Lu_code] = [Code], as seen below. Click OK.

Thenew Lu_codefield is populated with the same values as the Code field.

Click the Field Calculator again to populate the Description column field.

(®> = iotes Of £ (2] N [Lu_code Description [alue] =] MNumber + -]
il Attributes 0F [~ 07 Unclassified 0 {Ez;:;] & Sting g2 [
Altributes of L| 100 : Urban and Built-Up Land 100 ~ Date .
211 : Dryland Cropland and Pasture 211 o cde] e
212 lrigated Cropland and Pasture 212 [De_scnptlon] =
280 i Cropland/Grassland Mozaic 280 = 7 LI
290 i Cropland”+/oodland Mosaic 290
Charts 311 ; Grassland an [Description] =
321 Shubland 32 =
330 Mixed Shrubland/Grassland 330
332 Savanna 332 I
Laouts 411 i Deciduous Broadleaf Forest 411 Cancel
421 ; Evergreen Broadleaf Forest 421 =
5 — 422 ¢ Evergreen Meedleleaf Forest 422
el Jud 430" Mived Forest 430
A

The Field Calculator dialog box opens—double-click [Name] under Fields.
The calculation is expressed as [Description] = [Name]. Click OK.
The new Description fields are populated with the same values as the Name fields.
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Next, remove the join leaving Value, Count, Lu_code, and Description fields.
From the Table menu, select Remove All Joins.

From the Table menu, select Save Edits. Click Yes.

From the Table menu, select Stop Editing. Click Yes.

The USGS Land Cover grid can be added to the View when prompted during the M ethod
of OverLand Flow Velocity Computation processin the unit hydrograph computation process.
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Appendix 4: Processing Soil Characteristics

Create anew folder for DSMW datato be stored in the GeoSFM folder. Download DSMW
data from the CD into c:\geoSFM\dsmw. The downloaded files are:

1STREAD
ERDAS
FAOSOIL
IDRISI
RASTEXPN
VECTOR
READI1ST .txt

Now you can begin to import the datainto an ArcView project for usein GeoSFM. First,
import the vector files by clicking Start/Programs/ESRI/ArcView 3.2a/lmport71, as seen below.

The vector files are found in the Vector folder where they are listed by 10 different regions.
Thefilesfor the study areain thistutorial are the 10 filesfor Africa, AFSNTLL.e00 —*.e09. By
selecting .e00, al files are added. Browse to populate Export Filename:

c:\geoSFM\dsmw\Vector\AFSCNTL L .EQO.

Browse to populate the Output Data Sour ce and click OK.

The Import71 Utility dialog box displays, stating lmport Complete. Click OK.

94



Import71 Utility x|

CihaeoSFMIDSM AFSCHTLL

Import Complete.

Add the AFSCNTLL fileto the View using the Add Theme button from the View
menu. Change the Data Sour ce Types to Featur e Data Sour ce. Click the afscntll file from the
c:\GeoSFM\dsmw directory and click OK to add to the View.

Next, convert Afscntll to a shapefile. Select the theme Afscntll so that it appearsin araised
box. From the Theme menu, select Convert to Shapefile.

The Convert Afscntll dialog box appears. Navigate to the c:\GeoSFM\dwms directory and
name your new shapefilein File Name. Click OK.

The new shapefile is added below.
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Next, you need to project the shapefile to Lambert Equal-Area Azumuthal projection.
Start by activating the Projector! Extension. From the File menu, select Extensions. Scroll
down to Projector! and click the box to the left to select it. Click OK.

Thetool bar is updated to add the change pr oj ection button.

Click the change projection button to start the projection process. Thefirst dialog box is
displayed. Select meters from the drop-down list for the output units. Click OK.
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Next, the Projection Properties box is displayed. Select the Custom radio button. In the
Projection drop-down list, select Lambert Equal-Area Azimuthal. Change the Central
Meridian to 20 and the Reference L atitude to 5 for the continent of Africa.

Click Y eswhen prompted, Recalculate area, perimeter and length fields (if present)
using meters?

Click Yeswhen asked to Add projected shapefiles asthemesto a view.

Next, select the view where you want the theme added. Select View1 and click OK.

97



Navigate to your directory, and under File Name, name your new projected shapefile. Click
OK.

Now you can delete the original africasoil.shp. From the Edit menu, select Delete Theme.
(Make sure your themeisin araised box.)

VMiew Theme Analysis
Cut Themes
| Copy Themes

' Unda Giaphic Edit CilZ |
Before you begin creating the soil depth grid, add the elevations theme to your view. Use
this theme to define the output grid extent and the cell size. Add the elevationsfile to the View

+
using the Add Theme button from the View menu. Change the Data Sour ce Typesto Grid

Data Sour ce. Click the elevations file from the c:\GeoSFM\demdata directory and click OK to
add to the View.
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Now you can begin to create six different soil characteristic grids; these grids will be
needed for generating the Basin Char acteristics File.

Soil Depth

Soil depth will be thefirst grid created; it isahydrological active soil layer depth grid. The
source for this datawill be a data set found in NASA Technical Memorandum 4286 (Webb and
others, 1993). It contains a soil thickness data set with 106 soil types for six continents. The datain
the Soil Code and Africa columns are required for completing this tutorial. Create a text document
with two columns of data, as shown below.

Popul ate:
File name:
“ afsoildepth.txt”

Save astype:
CSV (Comma
delimited) (*.csv)

Thetableis displayed in Notepad.
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The soil depthsin thisfile are associated with soil types (depicted by soil codes). To map
the spatial distribution of soil depth, the soil codes must be associated with specific soil polygons
so that the depths can be transferred to the polygons. The soil polygons for Africaare stored in two
files, AFRIC1.DAT and AFRIC2.DAT, which are found in the FAOSOIL\DATA folder on the
DSMW CD. The datain the Faosoil column (4" column) and the Soil Code column (8" column) of
these two files must be extracted into a new text document.

Popul ate:
File name:
“ soilcode.txt”

Save as type:
CSV (Comma
delimited) (*.csv)

Thetableis displayed in Notepad.
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Now add the tables to a View by selecting Tables and clicking the Add button in the

Proj ect window. First, select the soilcode.txt as seen below. Click OK.

Open the attribute table of Projafsoil.shp by selecting the Projafsoil theme and clicking the

Tableicon on the tool bar.

Position the tables as seen below. Highlight the common column headers in both tables—
Faosoil in Attributes of Projafsoil and Faosoil in soilcode.txt. Make the destination table active
(adding fieldsto Attributes of Projafsoil.shp).

-

2 Attributes of Projafsoil.sh

41 soilcode.bxt

111132 Bk2d-be || Edbe Tl

21514 | Lgae-ae Il Ree i

11732 Bk2dbe BRi525 Bh

411972 WATER Nebi-3h Ne

1740 Vipdd-dah Feida Fe

1704 Sola SALT T

71350 Kasa Bli0-7 a0 Bk

BT40 T Laa0ahe BEA0-2E B

91347 Jciba Bl117b Bk

10°1079 Bok2h Bl1Z2a Bk

11 1EES T Fdd- oa Bled 3 B

S EEPE T | | e s -

=l | C | I

I«

Click the Join icon. The new column is added to the Attributes of Projafsoil table.
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Again, select Tables and click the Add button in the Pr oject window to add the second
table to the View. Thistime, select afsoildepth.txt. Click OK.

Position the tables side by side. Highlight the common column headers in both tables—Soil
codein Attributes of Projafsoil and Soilcode in afsoildepth.txt. Make the destination table active
(adding fieldsto Attributes of Projafsoil.shp).

Click the Join icon. The new column is added to the Attributes of Projafsoil table.

Now add a new field to the Attributes of Projafsoil.shp. From the Table menu, select
Start Editing.

Field  window

Properties. ..

Chart...

: Start Editing
| Save Edits
I

Then from the Edit menu, select Add Field.

iew GIS 322 |
1@ Table Field in
Lot [l
LCopy [l
Easte [Ctrl+4

Undo Edit  ChleZ
Redo Edit  Chrl+y

Add Becord Chrl+é

The Field Definition dialog box opens.
Popul ate:

Name: with the name of your new field
Type: number

Width: defaults to 16; changed to 3
Decimal Places: 0

Select the calculator icon on the tool bar.

T
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The Field Calculator opens. Enter the following calculation:
[soildepth] = [Africa]
Click OK.

The new soildepth field will be populated with the values from the Africa field.

In the Table menu, select Save Edits to save the changes to the attribute table. Then in the
Tables menu, select Stop Editing. Create anew grid with the data from the soildepth field. From
the Theme menu, select Covert to Grid.

The Convert Projafsoil.shp dialog box opens. Select the c:\geosfm\dsmw directory and
name your grid in Grid Name. Click OK.
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The Conversion Extent dialog box opens. In Output Grid Extent, select Same as
Elevations from the drop-down list. In Output Grid Cell Size, select Same as Elevations. The
other values will default. Click OK.

Next, the Conversion Field dialog box opens. In Pick field for cell values, select
soildepth. Click OK.

When asked to Add grid asthemeto theview, click Yes.

The new Africa soil depth grid is displayed.
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Texture

The second required data layer is the soil texture grid. GeoSFM uses three different texture
classes (coarse, medium, and fine) for defining basin soil characteristics. The soil texture data set
used in the model isfrom Zobler (1986). It is contained in afile named
FAQ_soil.textur.lnnegl.bin, which is stored at the following FTP site:
ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrology/soil/. The following procedure is needed before
importing these binary filesinto ArcView. First, thefileis renamed from
FAO_soil.textur.1nnegl.bin to texture.bil. Next, a header fileis created with the following
parameters:

ncols: the number of columnsin the data set

nrows:. the number of rowsin the data set

xllcorner: the x-coordinate of the center or lower-left corner of the lower-left cell

yllcorner: the y-coordinate of the center or lower-left corner of the lower-left cell

cell size: cell size of the data set

nodata value: value in the file assigned to cells whose value is unknown. This keyword and
valueis optional. The nodata value defaults to —-9999.

byteorder: the byte order of the binary cell values. Y ou can choose between two keywords,
msbfirst or Isbfirst. Msbfirst is used for cell values written with the most significant bit first.
Lsbfirst is used for cell values written with the least significant bit first.

The parameters needed to popul ate the new header file can be found in the
Readme.fao_soil documentation. The parameters of the header file are saved in an ASCI|I file
using any simple text editor, such as WordPad, as shown in the example below.

B texturehdr - WordP 1ol x|

File Edit Yew Insert Format Help

D|2|B| 22 s 2|
heols 360

nrows 180
x1lleorner —-180
vlleorner -390
cellsize 1

nodats walue -9599
byteorder mshfirst

Save the document. From the File menu, select Save As.
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ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrology/soil/

File Name: texture.hdr
Save as Type: Text Document
Directory: c:\GeoSFM\Zaobler

Next, import the textur e.bil file. From the File menu, select Import Data Sour ce.

i Arc¥iew GIS 3.2a

Edit Yiew Theme Ana
LCloze
Cloze &l

SetWarking Directony...
Save Project Chil+3

Save Project As...

= T

Extensions...

Brinit....
Frint Setup...

Export...

Manage Data Sources...

Import Data Source. .

Export [iata Source...

Ezit

The Import Data Sour ce dialog box is displayed; from the drop-down list, select Binary
Raster. Click OK.

Navigate to your directory and change the List Files of Typeto All Files (*.*). Now you
can select the textur e.bil to populate the File Name. Click OK.
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The Output Grid dialog box opens. Navigate to your directory and name your new grid
under Grid Name. Y ou are now converting the .bil fileto agrid. Click OK.

Select Y es when prompted to Add grid asthemeto the View.

The new Texturegeo grid is displayed.

Zoom into the continent of Africa by clicking the zoom icon and putting a box around
Africa. To accomplish this, click one corner of the area you want to capture, then hold the mouse
button and drag to the opposite corner, boxing in Africa. See display below.
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Now set the analysis extent to the display so you can clip the African continent (what is
captured in our display area) from the global data set.

From the Analysis menu, select Properties. Select Same As Display from the drop-down
list to define the Analysis Extent. Use the default values for al other fields. Click OK.

The Analysis extent is now defined; using the Map Calculator, you can clip the extent
areafrom the global data area. To accomplish this, click the Analysis menu and select M ap
Calculator. From here, select the Textur egeo layer. Click Evaluate.
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The Map Calculation 1 themeis displayed below. Y ou now have agrid of Africa

Next, the data set must be transformed from the geographic projection to the Lambert
Equal-Area Azimuthal projection to match the other data sets used in the GeoSFM. From the
GeoSFM Utilities menu, select Raindata: ProjectGrid, Geo to Lambert Azimuthal. Normally,
this function is used for projecting rain and PET data, but you can project any grid except for large

global data sets.

Raindata: Unzip, Untar, Imagegrid

Raindata: ProjectGnd, Geo to Lambert Azimuthal

15 Toals: Compute B ain/Evap Grid Statistics
[E1S Trnlz Pick Gnd Yalues at Print

In the first window, Specify your working directory isdisplayed. Click OK.
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Next, Select the continent for analysisis displayed; from the drop-down list, select Africa.
Click OK.

Click Y es when prompted to project the grid to Lambert Equal-Area Azimuthal.

Use default values for Analysis Properties. Click OK.
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Thelast dialog box informs you that the data set will need to be saved. Click OK.

Before you save the data set, change the cell size to match the cell size of the other datayou
are using. First, add the elevations grid. Click the Add theme icon. Navigate to the demdata
folder. Change Data Sour ce Typesto Grid Data Sour ce and select elevations. Click OK.

After the elevations theme is added, click the Analysis menu and select Properties.

Popul ate:
Analysis Extent —
Same AsMap
Calculation 1

A

AnalysisCell Size—
Same As Elevations

Analysis Mask —
Elevations

Click OK to define the cell size for resampling the Map Calculation 1. From the Analysis
menu, select Map Calculator. Double-click Map Calculation 1 under layers to populate the
Evaluate window. Click the Evaluate button.
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Map Calculation 2 isnow projected with a cell size of 1,000.

Save the data set. From the Theme menu, select Save Data Set.

Analysis  Surface  Graphics

Properties. .

Start Editing

Save Edits

Save Editsfis.
Cotvert ta Shapefils,.
Corwert to Grid...

.= enE

Save Data Set..

= = I

EAit | amaimd

Navigate to your working directory and name your new grid. Click OK.
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+
Add the projtexturefile to the View using the Add Theme button from the View
menu. Change the Data Sour ce Typesto Grid Data Sour ce. Navigate to your working directory
and select projtexture. Click OK to add to the View.

To delete Map Calculation 2, select the theme in your table of contents. Then from the
Edit menu, select Delete Themes.

Yiew Theme Analysi
Cut Themes
Copy Themes

Defete Themes

L | oy ) |

Ihda Graphic Edit Chilvz
Cut Graohics [Strl

A new projected texture grid is displayed below.
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Next, you need to convert the seven different texture classes to GeoSFM’ s three classes.

To begin this process, you need to work with integers. From the Analysis menu, select the
Map Calculator. Double-click projtextur e to populate the evaluation window and type in the
following expression exactly as shown:

([Projtexture]) .Int

Click Evaluate.

Now you are working with values 0—7. —M ap Calculation 1.
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Next, define GeoSFM class 1 as consisting of classes 1 and 2 from the Map Calculation 1
theme. From the Analysis menu, select Map Calculator and typein the following expression
exactly as shown:

([Map Calculation 1] = 1) or ([Map Calculation 1] = 2).Con(1.AsGrid, 0.AsGrid)

Click the Evaluate button.

Next, define GeoSFM class 2, which is classes 3, 4, and 7 from the Map Calculation 1
theme. From the Analysis menu, select Map Calculator and typein the following expression
exactly as shown:

([Map Calculation 1] = 3) or ([Map Calculation 1] =4) or ([Map Calculation 1] =
7).Con(2.AsGrid, 0.AsGrid)

Click the Evaluate button.

115



Similarly, define GeoSFM class 3 using class 5 from the Map Calculation 1 theme by
selecting Map Calculator from the Analysis menu and typing in the following expression and
clicking the Evaluate button: ([Map Calculation 1] =5).Con(3.AsGrid, 0.AsGrid)

Next, you need to combine the results from Map Calculations 2 and 4 into asingle grid with
two classes. From the Analysis menu, select Map Calculator and type in the expression exactly as
shown below and click the Evaluate button.

([Map Calculation 2] = 1).Con([Map Calculation 2],[Map Calculation 4])
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Asafinal calculation, allow the third class to be combined with the previously combined
grid to create anew grid with all three classes. From the Analysis menu, select Map Calculator
and type in the following expression exactly as shown and click the Evaluate button.

([Map Calculation 6] = 0).Con([Map Calculation 5],[Map Calculation 6])

Map Calculation 7 isthe final grid with the corrected texture classes. To save this data set,
click Map Calculation 7 to activate the theme in the table of contents. From the Theme menu,
select Save Data Set.
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bnalysic  Suface  Graphics W
Properties... 7
Start Editing
Save Edits
Save Edits A=,

Convert to Shapefile...
Convert to Grid..

.

Save Data Set...

e

Edit Legend...
Hide/Show Legend 8

Navigate to your working directory. Type in the grid name, texture, and click OK.

Final Texture gridisdisplayed below.

Hydraulic Conductivity

The third soil characteristic grid required is the hydraulic conductivity, Ks. The values are
assigned based on the seven Zaobler texture classes. First, add the projtexture grid used in defining

the texture classes. Add the projtexturefile to the View using the Add Theme button from
the View menu. Change the Data Sour ce Typesto Grid Data Sour ce. Navigate to your working
directory and select projtexture. Click OK to add to the View.
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From the Analysis menu, select the Map Calculator.

 Suface Graphics |

PBroperties...

Find/[istance
Azsian Frowmity

Calzulate Depsity..

Cell Statistics. .
SUmmarnze Lones. .
Histogram By Zone...
Tlabulate Areas...

Map Quen...

Map Calculator...

Heighborhood Statistics. .

Beclazsify...

This opensthe Map Calculator window. Double-click projtexture to populate the
evaluation window and type in the following expression exactly as shown and click Evaluate.

([Projtexture]) .Int

This producesthe Map Calculation 1 grid with values 0—7.
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Ksvalues (in cm/hr) are assigned based on the seven texture classes in the Zobler (1986)
data set as follows: 5.076 for coarse, 1.882 for medium/coarse, 1.217 for medium, 1.602 for
fine/medium, 0.882 for fine, 0.0 for ice, and 1.217 for organic soils. From the Analysis menu,
select the Map Calculator. Typein the following expression exactly as shown:

([Map Calculation 1] = 1).Con(5.076.AsGrid, ((Map Calculation 1] =
2).Con(1.882.AsGrid, ([Map Calculation 1]=3).Con(1.217.AsGrid, ((Map Calculation
1]=4).Con(1.602.AsGrid, ([Map Calculation 1]=5).Con(0.882.AsGrid, ((Map Calculation
1]=7).Con(1.217.AsGrid, [Map Calculation 1]))))))

Once the new grid is created, you can check your data values by selecting both your new
grid (Ksor Map Calculation 2) and the projtexture or (Map Calculation 1) grid. To select more
than one Theme at atime, hold down the shift key while making your selections. Click the
I dentify icon and then click acell in your grid.
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The Identify Results window will open showing the values. If the Ks grid is highlighted in
the table, the Ks value will display—1.217 as shown below. If the projtexture or Map
Calculation 1 is highlighted, then the value is 3. This corresponds with our original table, where
the texture value 3 has aKsvalue of 1.217.

- -

The Map Calculation 2 grid isthe final Ksgrid, so we will save this data set. From the
Theme menu, select Save Data Set.

IGENEN Lnalpsiz Swface  Graphics
Broperties...
Start Editing
Sawve Edits
Save Edits ds..
Carvert ta Shapefile..
Caonwert ta Grid...

Save Data Set..

il cmend

Navigate to your working directory and name your new grid Ks. Click OK.

+
Add the Ks grid to the View using the Add Theme button from the View menu.
Change the Data Sour ce Typesto Grid Data Sour ce. Navigate to your working directory and
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select Ks. Click OK to add to the View. The other Themes can be deleted by selecting the themes
and then from the Edit menu selecting Delete Themes. Below isthe final Ks grid.

WHC - Soil Water Holding Capacity

The next required soil characteristic grid is the soil water holding capacity grid. The source
for this datawill be the SM AXI.ASC file found on the FAO Digital Soil Map of the World CD in
the FAOSOIL\DATA\folder. The datain this file must be joined to the projafrica.shp file. Begin
by opening the SMAX1.ASC filein WordPad. Add aline at the top for header information. The
file contains a record number (RecNum), the mapping unit name (M apUnit), and the soil classes
(Water, A, B, C, D, E, and F) as shown below.
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From the File menu, select Save As. Navigate to your directory.

I | P_opul ate:
| File name: .o =] == 'I File name:
Saveastype: [ Text Document = Cancel | WHC.txt
™ Save in this fomat by defaul Y Save as type:
Text Document

Next, add the projafsoil.shp file to the View. Add the shapefile to the View using the Add

|
Theme button from the View menu. Change the Data Sour ce Typesto Feature Data
Sour ce. Navigate to your working directory and select projafsoil.shp. Click OK to add to the
View.

In View, click projafsoil.shp so it appearsin araised box. Click the Open theme table

icon.

Next, you need to add the new whc.txt to the View. From the project window, select Tables
and click the Add button. Navigate to your working directory and select whc.txt. List Files of
Type which will need to be Delimited Text (*.txt). Click OK.

123



Arrange both tables as seen below. Highlight the common column headers in both tables—
Faosoil in Attibutes of projafsoil.shp and Mapunit in whc.txt file. Make the destination table
active (adding fields to Attributes of Projafsoil.shp).

H |72 Attributes of Projafsoil.sh ol
- B !
1:1132: Bk24-be ﬂ 1: Af14-3c 0 0.00000:80,00000: 00: 0.0 [ﬂ
2:1514: Lg32-2c J 2:Af17-1/2ab 10 0.00000:55.00000:250: 0.0 [J
3i1132 Bk24-be 31 Af32-2ab 10 0.00000:70,00000:100% 0.0 C
4:15972 i WATER 4:4039-2h 0: 0.00000:7000000: 00f 00 C
5i1740 Wpdd-3ab 5:Aadl-2be 0: 0.00000:1000000: 00¢ 0.0: C
Ei1704:501-a 6:AoB3-3h 10: 0.00000:90,00000: 00¢ 0.0: C
Fi1390: K3-3a 7iBcB-2b 0F 0.00000:8000000: 00: 0.0¢ C
8:1401 { La30-2bc 8:Bc9-2b 0 0.00000:70,00000:300¢ 0.0¢ C
9:1347 i Jc1Ba 9:Bda0-2/3c 0: 0.00000:4000000: 00§ 0.0:5C
10:1079: Beb-2b 11:Bd3-2c 0: 0.00000:1000000: 00F 0.0:3C
11 $1653 i Rdd-1/25 16 Bed5-2a 0:30.00000:70,00000: 00¢ 0.0: C
104047 lad i/ - ;I A7 iR -AT A LNl [uW nluln T in R nia W TaTaTau R Ta N nl [aNu} r;l
M R | V]

Click the Join icon; the new columns are added to the Attributes of Projafsoil.shp table.

Now add a new field to the attribute table. From the Table menu, select Start Editing.

Figld  Window

t
T Eroperties...

LChart. ..

Start Editing

Then from the Edit menu, select Add Field.
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cYiew GIS 3.2a

Table Field ‘i

[Cut [l
[Eopy [+
Paste [l

Undo Edit  Chri+2
Fedo Edit  Chil+Y

Add Becord  Chil+ |

The Field Definition box opens.
Populate:

Name: whc

Type: Number

Width: 5

Decimal Places: 3

Click OK.
Select the calculator icon on the tool bar.

Thiswill display the Field Calculator; enter the following expression:

(((Water] / 100) * 0) + (([A] / 100) * 250) + (([B] / 100) * 175) + (([C] / 100) * 125) +
(([D] / 100) * 80) + (([E] / 100) * 40) + (([F] / 100) * 10)

Click OK.
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Thewater, A, B, C, D, E, and F values correspond with the soil class values listed in the
attribute table. The values that are multiplied are the median soil moisture and the total available
water. After afew moments for processing, the whc values are populated in the new column.

’:‘ Attributes of Projafsoil.shp

Lo

A

LA R

10¢

0.000a0

40.00000
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20.00000
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0.00000
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0.00000

30.00000

0.00000

140.0

o

0.00000

100.0000

0.00000

175.0

20

0.00000

#0.00000

0.00000

135.0

o

0.00000

100.0000

0.00000

175.0

40

0.00000

40.00000

0.00000

36.50

o

0.000a0

100.0000

0.00000

175.0

0

0.00000

£5.00000

0.00000

157.5

Aan

1l

oo

AN nnnnn

nonnnnn
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Next, you will save the edits; from the Table menu select Save Edits.

Field ‘indow
Properties...
Chart...
Stop Editing
Save Edits
Save Edits &3...
Eind.. Ctrl+F
Quemn... Chil+0

Eromate

The Save Edits dialog box is displayed; click the Y es button.
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From the Table menu, select Stop Editing. Thiswill end the editing session.

Field window

Broperties...

Lhart...

Stop Editing
Save Edits

Set the Analysis extent before you create the new whc grid. Add the elevations grid to the

View. Add the grid to the View using the Add Theme button from the View menu. Change
the Data Sour ce Typesto Grid Data Sour ce. Navigate to your working directory and select
elevations. Click OK to add to the View.

Now, from the Analysis menu, select Properties. The Properties dialog box is displayed.
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Popul ate:
Analysis Extent:

Same As Projafsoil.shp
Analysis Cell Size:

Same As Elevations

A

Click OK.
From the Theme menu, select Convert to Grid.

B.2
&halpsiz - Surface  Graphics

Eroperties. ..

‘

Start Editing

Save Edits

Save Edits Az,
Convert to Shapefile...

=

Corvvert o Grid....

Saye Data 5etb.

Edit Legend...
Hide/Show Leaend

Te T T-F

Navigate to your working directory and type in the Grid Name—whc. Click OK.

When prompted for Conversion Field, select whc from the drop-down list. Click OK.
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Click Yeswhen asked to Add grid asthemeto the View.

The new whc grid is shown below.

Maxcover

The next required soil characteristic grid is the maximum impervious area, maxcover. It is
the area covered by awetland or water body in the GLCC data or designated as a stream in the flow

accumulation grid. Add the grid to the View using the Add Theme button from the View
menu. Change the Data Sour ce Typesto Grid Data Sour ce. Navigate to the land cover directory
and select usgslandcov. Click OK to add to the View.
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Next, add the flow accumulation grid to the View. Add the grid to the View using the Add

. .
Theme button from the View menu. Change the Data Sour ce Typesto Grid Data Sour ce.
Navigate to the workspace directory and select flowacc. Click OK to add to the View.

Next, define the analysis extent.

Populate:

Analysis Extent:
Same As Flowacc

Analysis Cell Size:
Same As Flowacc

A
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Click OK. Next, select all water bodies and wetland areas from the land cover grid
including values 16 (Water Bodies), 17 (Herbaceous Wetland), and 18 (Wooded Wetland). From
the Analysis menu, select the Map Calculator. Type in the following expression exactly as shown
below and click the Evaluate button:

([Usgslandcov] = 16).Con(1.AsGrid, ([Usgslandcov] = 17).Con(1.AsGrid,
(JUsgslandcov] = 18).Con(1.AsGrid, 0.AsGrid)))

This creates Map Calculation 1 with all water body and wetland cells assigned a value of
1; all other cells are assigned avalue of 0.
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Next, select all cellswith avalue equal to or greater than 1,000 in the flow accumulation
grid. These cells are defined as streams in the flow accumulation grid. From the Analysis menu,
select the Map Calculator. Typein the following expression exactly as shown:

( [Flowacc] >= 1000).Con(1.AsGrid, 0.AsGrid)

Click Evaluate.

This creates M ap Calculation 2 with all stream cells assigned a value of 1; al other cells
are assigned avalue of 0.
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The next calculation combines the water body, wetland, and stream cells into one grid.
From the Analysis menu, select the Map Calculator. Type in the following expression exactly as
shown:

([Map Calculation 1] = 0).Con([Map Calculation 2], [Map Calculation 1])

Click Evaluate.

Y ou have created a grid with all water bodies, wetlands, and streams assigned a cell value
of 1. All other cell values are assigned a value of 0.

Save the new grid; from the Theme menu, select Save Data Set.
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Navigate to your directory; name your grid maxcover in Grid Name. Click OK.

Delete the themes you no longer need from the table of contents. From the Edit menu,
select Delete Themes.

Yiew Theme Analpsis
Cut Themes
Copy Themes

Delete Themes

Undo Graphic Edit CirlsZ

Cut Graphics [Ctrl+
Copy Graphics [Ctrl+HE

Add the new maxcover grid to the View. Add the grid to the View using the Add Theme

button from the View menu. Change the Data Sour ce Typesto Grid Data Sour ce. Navigate
to your dsmw directory and select maxcover. Click OK to add to the View.
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Below isthe final maxcover grid.

RCN

The last required soil characteristic grid is the Soil Conservation Service (SCS) runoff curve
number (RCN) grid. SCSisthe former name of the U.S. Department of Agriculture Natural
Resources Conservation Service (NRCS). The runoff curve numbers are estimated from land cover
classes and hydraulic soil groups. First, add the land cover grid. Add the grid to the View using the

. .
Add Theme button from the View menu. Change the Data Sour ce Typesto Grid Data
Sour ce. Navigate to the land cover directory and select usgslandcov. Click OK to add to the View.
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Then add the protexture grid. Add the grid to the View using the Add Theme button
from the View menu. Change the Data Sour ce Typesto Grid Data Sour ce. Navigate to your
directory and select projtexture. Click OK to add to the View.

After you have added the landcover and projected texture grids to the View, set the
Analysis Extent. From the Analysis menu, select Properties. The Analysis Properties dialog box
will be displayed.

Popul ate:
Analysis Extent:

Same As Usgslandcov
Analysis Cell Size:

Same As Usgslandcov

A

To begin this process you need to work with integers. From the Analysis menu, select the
Map Calculator.
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m Suface  Graphics

Eroperties. ..

Find|Miztance
Azzign Prowinity

Calculate Density.

Cell|Statistics...
Summanze Zones...
Histogram By Zone...
Tabulate freas...

Map Queny...

Map Calculstar...

Meighborhood Statistics. .

Beclassify...

This opensthe Map Calculator window. Double-click projtextureto populate the
evaluation window. Type in the following expression exactly as shown:

([Projtexture]) .Int

Click Evaluate.

This produces the Map Calculation 1 grid with values 0—7.
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Next, create a soil hydraulic class grid. A text file, “texture.txt,” containing the texture
classesisrequired. Thisfile was created earlier in thistutorial. Add the new texture.txt to the
View. From the project window, select Tables and then click the Add button. Navigate to your
working directory and select texture.txt. List Files of Typeisset to Delimited Text (*.txt). Click
OK.

Join the textur e.txt to the attribute table of Map Calculation 1. In the View click the Map
Calculation 1 theme so it appearsin araised box, then click the Open theme tableicon. Arrange
tables side by side. Highlight the common column headers in both tables—Value in Attributes of
Map Calculation 1 and Index in the textur e.txt file. Make the destination table active (adding
fieldsto Attributes of Map Calculation 1).

1 texture.bxt

i Attributes Of ... [E=] B3

i gast a7 coarse -
1 T4BEE7 2 mediurm or coarse 0434 01413:1.882: 474
21 2038723 3 medium 0.439 0.3548:1.217; 525
3 72413 4 fine ar medium 0.404 0.1349:1.602; B77
4! 1980456 5! fine 0.465 0.2630:0.882; 817
5i 321305 Giice 0.000 0.0000:0.000; 0.00
7 13672 7 | organic 0.439 0.3548:1.217; 525
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Click the Join icon. The new columns are added to the Attributes of Map Calculation 1
table.

Now you can create agrid of the Numeric soil hydraulic classes. From the Analysis menu,
select the Map Calculator. Typein the following expression exactly as shown:

([Map Calculation 1. Numeric soil hydraulic class])

Click Evaluate.

The created grid is displayed below with values of 0, 88, 89, 90, and 91.
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Save this data set; from the Theme menu, select Save Data Set. Navigate to your directory
and name your new grid—soilhyd. Click OK.

Now you can delete all themes except for the usgslandcover grid; from the Edit menu,
select Delete Themes. Make sure the themes you want deleted are selected in araised box. Now
add the new soilhyd grid to the View. Create four grids for each Soil Hydraulic class (A, B, C, and
D) with the RCN values for the landcover classes. The Hyd_a mean field in the usgslandcov
attributes table indicates the RCN values for soil hydraulic class“A,” Hyd_b_mean for soil
hydraulic class“B,” Hyd_c_mean for soil hydraulic class“C,” and Hyd_d_mean for soil
hydraulic class“D.” If the attribute table does not contain these Hyd _a—d_mean values, one has
been created for you in the GeoSFM/Samples directory with the file name “rcn.txt.”

File name: — ['ren.bxt” =l Save I
Save as typet [y (Comma delimited) (*,csv) =l Cancel |
£
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Add the new rcn.txt to the View. From the project window, select Tables and then click the
Add button. Navigate to your working directory and select rcn.txt. List Filesof Typeisset to
Delimited Text (*.txt). Click OK.

Arrange the tables side by side. Highlight the common column headers in both tables—
Valuein Attibutes of Usgslandcov and nlucode in the rcn.txt file. Make the destination table
active (adding fields to Attributes of Usgslandcov). Click the Join icon; the new columns are
added to the Attributes of Usgslandcov table.

Next, create four separate grids for each of the soil classes. The first grid will capture all the
Hyd_a mean values. From the Analysis menu, select the Map Calculator. Type in the following
expression exactly as shown:

(JUsgslandcov.Hyd_a mean])

Y ou can double-click the field under L ayer s to populate the evaluation area. Click Evaluate.

Save your new data set; from the Theme menu, select Save Data Set.

Navigate to your working directory and type a rcn inthe Grid Name. Click OK.
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Repeat this process for the remaining three grids. The second grid will capture the
Hyd _b_mean values and be saved asb_rcn. Thethird grid will capture the Hyd_c_mean values
and be saved asc _rcn. Thelast grid will capturethe Hyd _d_mean values and be saved asd_rcn.
Delete al the Map Calculation 1-4 grids, and add the newly created a rcn, b_rcen, ¢ ren, and
d_rcn grids. You can select more than one grid by holding down the shift key while selecting. Add

the grids to the View using the Add Theme button from the View menu. Change the Data
Sour ce Typesto Grid Data Sour ce. Navigate to your directory and select the four grids. Click OK
to add to the View.

The next step isto combine the grids into one final rcn grid. From the Analysis menu, select
the Map Calculator. Type in the following expression exactly as shown below and click Evaluate.

([Soilhyd]=88).con([A_rcn],([Soilhyd]=89).con([B_rcn],([Soilhyd]=90).con([C_rcn],([S
oilhyd]=91).con([D_rcn], 0.AsGrid))))
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Save your new data set, from the Theme menu, select Save Data Set.

Navigate to your working directory and type rcn in the Grid Name box. Click OK.

Y ou can now delete all the themes in the View and add your new rcn grid as seen below.
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All of the soil characteristic grids have been created. Now the soil grids can be added to the
View when prompted during the Creating Basin Char acteristics process.
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Appendix 5: Creating Reservoir and Gauge Rating Files

Reservoir characteristics files (reservoir.txt) are created whenever dams are present on a
river or stream within the basin being analyzed. A dam insertion utility isincluded in GeoSFM for
this purpose. On the View Toolbar, click the dam icon to select it.

O

In the View window, position your mouse on the stream containing the dam. L eft-click your
mouse and a Dams shapefile will be added to your project. In the first dialog box displayed, select
basply.shp from the drop-down list. Click OK.

Inthe Key Field dialog box, select Gridcode.

Next, enter the reservoir parameters. The Dam | D will populate with the Basin ID of the
selected point on the stream. The Stor age value is needed aong with the Residence Time in days.
The Operated field is populated with either a0 or 1 depending on a user-defined file. (0 if nofile,
1if thereisafile) If thefile is needed, the file path and name will be populated in the Operation
FileNamefield. Click OK.

145



The dam is added to the View. This process will create areservoir .txt file.

It may also be necessary to insert a stream gauge into the model for Muskingum Cunge
computations. If you need to input streamflow data from stream gauges, the data will need to be in
aformat asin thefile below. The first column header is BasinlD, starting with the most
downstream basin. The next column header is Type, which will be populated with either a1 or 2
depending on the type of rating equation being used. The next three column headers are the three
different equation parameters—Par1, Par2, and Par3. The last column is hmax, which is populated
with the maximum flow height where the equation is valid. Create the file using Microsoft Excel
spreadsheet software.

A samplerating file is shown below.

File Edit Format Wiew Help

EasinID, type,Parl,Parz,Par3, hmax
292,1,58.954,-0.752,1.867,7. 5
283,1,47.204,0,3759,1.8597,7
Z208,1,35.115,0.29,1.614,7
258,1,16.84,0.00,1.727,7.5
166,1,3%,.79,0.27,1.285,7
147,1,21.079,-0.631,1.468,10
144,1,4.904,0.073,2.073,6
142,1,11.86,-1.14,1.358,6.5

To save thefile, select File and Save As.
File name: “rating.txt”
Save astype: CSV (Comma delimited) (*.csv).

File name: — [rating.txt" = \&I
j Zancel

Save as bype: Hg

i

Enclosing the file name (r ating.txt) in quotation marks ensures that the rating file will
retain the specified file name when it is stored as a comma delimited file for subsequent use by the
Muskingum Cunge program.
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